Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Interplay Assist may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for Interplay products. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2018 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:  
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:

This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:

Copyright (c) 1989 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific, prior written permission. This SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (C) 1989, 1991 by Jef Poskanzer.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright (c) 1991 by AT&T.

Copyright © 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright © 1991 by AT&T.
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS". WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc. All rights reserved, worldwide. Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other trademarks are the property of their respective owners. All Nexidia materials regardless of form, including without limitation, software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the exclusive property of Nexidia Inc. or its licensors. The Nexidia products and services described in these materials may be covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415; 7,475,065; 7,487,086 and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
"Install-It" is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of "Install-It," including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
"Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose."

"This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow "frame accurate" editing control of applicable videotape recorder decks, videodisc recorders/players and the like."

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The "Interplay" name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
© DevelopMentor

This product may include the Jcifs library, for which the following notice applies:
Jcifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are "commercial computer software" or "commercial computer software documentation." In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.
Trademarks


Interplay | Production Software Installation and Configuration Guide • Created December 21, 2018 • This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.
Contents

Using This Guide ................................................................................................. 9
Symbols and Conventions .................................................................................. 9
If You Need Help. ................................................................................................. 10
Avid Training Services ........................................................................................ 10

Chapter 1  
Installation Overview ....................................................................................... 11
Using the Interplay | Production Installers ....................................................... 11
Copying the Interplay Installers to a Server ..................................................... 12
Upgrading Your Interplay Production Systems ............................................... 12
Installation Check List ...................................................................................... 12
Network Considerations ................................................................................... 15
  Time Synchronization. ...................................................................................... 16
Set Up and Configure an Avid Shared-Storage System ..................................... 16
  Shared-Storage Workspace Names ................................................................. 16
User Names and Passwords Required For Avid Shared Storage and Product Servers .... 16
  Creating the Server Execution User Account ................................................. 17
  Accounts for Accessing Workspaces through the Interplay Administrator .... 17
  Accounts for Using Deletion ........................................................................ 18
  Accounts for Using Interplay Transfer ......................................................... 18
  Service Framework Administrator Password .............................................. 18
  Accounts for Avid Editing Applications and Interplay Assist .................... 18

Chapter 2  
Installing Software on Interplay Servers ........................................................... 20
Starting the Interplay Server Installer ............................................................... 20
Installing Software on the Interplay Engine Server ........................................ 21
  Installing the Interplay | Engine Software ..................................................... 21
  Installing Interplay | Access .................................................................. 25
Installing Software on the Interplay | Transfer Server ...................................... 26
Installing Software on the Production Services and Production Services Provider Servers .... 26
  Installing the Production Services Engine ................................................... 27
  One-Time Configuration for Production Services Engine Upgrade ............. 28
Installing the Local Workflow Components .................................................... 28
Installing the WAN Workflow Components .................................................... 32
Installing the Media | Index Components ...................................................... 33
Installing Software for Interplay Web Services ............................................... 33
Installing the MediaCentral Distribution Service .......................................... 34

Chapter 3  
Installing Software on Media Indexer Servers .................................................. 35
Media Indexer Memory and Disk Space Requirements ..................................... 35
## Chapter 7  Software Licensing for Interplay Production

- Understanding Software Licensing for Interplay Production ........................................ 61
- Upgrading to Interplay Production v3.8 or Later .......................................................... 63
- Activating a Product .................................................................................................... 64
  - Activating a Single License ......................................................................................... 64
  - Activating Interplay Engine Licenses ......................................................................... 65
  - Activating Additional Licenses .................................................................................. 66
  - Activating a Product Without an Internet Connection. ........................................... 68
- Deactivating a Product ............................................................................................... 70
- Troubleshooting Software Licensing ......................................................................... 71

## Chapter 8  Additional Configuration Topics

- Using Antivirus Software in an Interplay | Production Environment .......................... 72
- Troubleshooting Firewalls and Interplay | Production .................................................. 72
- Integration of Journal Data into the Database ............................................................. 73
- Mounting Workspaces as Drives: Lettered versus Letterless ....................................... 74
- Using Time Synchronization in an Interplay | Production Environment ................. 75
  - Using the Avid Service Framework Time Sync Feature ............................................ 75
- Installing the Lookup Service on a Separate Server .................................................. 77
- Configuring Lookup Servers ....................................................................................... 78
- Connecting Systems Directly to the Lookup Service .................................................. 79

## Chapter 9  Workgroups with Multiple Shared-Storage Systems

- Understanding a Multiple Shared-Storage Workgroup .............................................. 81
- Check List for Adding Multiple Shared-Storage Systems to a Workgroup .............. 84
- Requirements for Multiple Shared-Storage Workgroups ........................................... 85
- Adding Remote Shared-Storage Systems to Client Software .................................... 86
- Configuring Media Indexer for Additional Shared-Storage Systems ....................... 88
- Adding Remote Shared-Storage Systems in the Interplay Administrator ............... 89
- Mounting ISIS Workspaces as UNC Paths ................................................................. 90
- Working with Production Services and Interplay Transfer in a Multiple Shared-Storage Workgroup .............................................................. 90

## Appendix A  Configuring the Copy Provider Server

- Workgroup Configuration for the Copy Service ......................................................... 92
- Creating Copy Provider User Accounts for Shared Storage and Interplay Production .............................................................. 93
- Copy Provider Configuration for AS3000 Servers .................................................... 94
  - Making the ISIS Connections on an AS3000 ........................................................ 95
  - Copy Provider ISIS Configurations ......................................................................... 96

## Appendix B  Configuring the Move Provider Server

- Move Provider Configuration for AS3000 Servers .................................................... 98
  - Using the Myricom Card on the Move Provider ...................................................... 99
Using This Guide

Congratulations on your purchase of Interplay® Production, a powerful system for managing media in a shared-storage environment. This guide contains overview installation instructions and configuration information for the Interplay components on the Interplay Production client and server installers.

This guide is intended for all Interplay Production administrators who are responsible for installing, configuring and maintaining an Interplay | Production Engine or Interplay | Production Archive Engine (database, server, and all related client connections and user rights) in an Interplay workgroup.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

<table>
<thead>
<tr>
<th>Symbol or Convention</th>
<th>Meaning or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![note icon]</td>
<td>A note provides important related information, reminders, recommendations, and strong suggestions.</td>
</tr>
<tr>
<td>![caution icon]</td>
<td>A caution means that a specific action you take could cause harm to your computer or cause you to lose data.</td>
</tr>
<tr>
<td>![warning icon]</td>
<td>A warning describes an action that could cause you physical harm. Follow the guidelines in this document or on the unit itself when handling electrical equipment.</td>
</tr>
<tr>
<td>&gt;</td>
<td>This symbol indicates menu commands (and subcommands) in the order you select them. For example, File &gt; Import means to open the File menu and then select the Import command.</td>
</tr>
<tr>
<td>![instruction icon]</td>
<td>This symbol indicates a single-step procedure. Multiple arrows in a list indicate that you perform one of the actions listed.</td>
</tr>
<tr>
<td>(Windows), (Windows only), (Macintosh), or (Macintosh only)</td>
<td>This text indicates that the information applies only to the specified operating system, either Windows or Macintosh OS X.</td>
</tr>
<tr>
<td><strong>Bold font</strong></td>
<td>Bold font is primarily used in task instructions to identify user interface items and keyboard sequences.</td>
</tr>
<tr>
<td><em>Italic font</em></td>
<td>Italic font is used to emphasize certain words and to indicate variables.</td>
</tr>
<tr>
<td><strong>Courier Bold font</strong></td>
<td>Courier Bold font identifies text that you type.</td>
</tr>
<tr>
<td>Ctrl+key or mouse action</td>
<td>Press and hold the first key while you press the last key or perform the mouse action. For example, Command+Option+C or Ctrl+drag.</td>
</tr>
<tr>
<td></td>
<td>The pipe character is used in some Avid product names, such as Interplay</td>
</tr>
</tbody>
</table>
If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was published. You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read or join online message-board discussions.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new training delivery methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, please visit www.avid.com/support and follow the Training links, or call Avid Sales at 800-949-AVID (800-949-2843).
Installation Overview

This document describes how to use the Interplay Production Servers installer and the Interplay Production Clients installer to install the various Interplay components. Instructions include the order in which to install items and any special considerations when you are combining services and applications on the same system.

See the installation check lists for the steps required to install the Interplay products.

This chapter includes the following topics:

- Using the Interplay | Production Installers
- Copying the Interplay Installers to a Server
- Upgrading Your Interplay Production Systems
- Installation Check List
- Network Considerations
- Set Up and Configure an Avid Shared-Storage System
- User Names and Passwords Required For Avid Shared Storage and Product Servers

Using the Interplay | Production Installers

Starting with Interplay v2.7, Interplay Production installers are delivered on the Avid Download Center. See the Interplay | Production ReadMe for additional information. There are three separate Interplay installers: one for Interplay servers and two for Interplay clients.

- Interplay Production Server Installer (Windows)
- Interplay Production Client Installer (Windows)
- Interplay Production Client Installer (Macintosh)

For Avid editing applications such as Media Composer, use the individual installers for the various Avid editing applications and then use the Interplay Client Installer to install the software required to make the Avid editing application a client in the Interplay Production environment.

*The application software for Interplay Assist is on the Interplay Production Client Installer.*

Additional Installation Programs on the Interplay Installers

Various installation programs for special purposes are included on the Interplay Production Installers, but are not accessible through the Installer user interface. You can browse the appropriate installer folders and select individual installers.
Copying the Interplay Installers to a Server

You can copy the Interplay Installers to a server so that you have easy access to installer files if you should ever need them in the future. In this topic, the folder that contains the software installation files is referred to as the software kit.

To copy the Interplay Installers to a server:

1. Log in as Administrator.
2. Make a folder for the software kit on the root directory (C:\) For example:
   C:\Installers\Interplay_2018_11_Servers
3. Open the folder containing the installer.
4. Copy the software kit into the new folder you created. For example, use CTRL-A to select all the files and folders in the software kit and copy and paste to the new folder you created.
5. Navigate to the software kit folder and double-click the Autorun.exe file.
   The Interplay Installer splash screen opens.
6. Install the application as described in this guide.

Upgrading Your Interplay Production Systems

⚠️ Complete instructions for upgrading previous versions of the Interplay Engine, along with other upgrading notes, are included in the Interplay | Production ReadMe.

The following items apply to upgrading the components on your Interplay system:

- Back up your Interplay database and any other user data before you upgrade. See “Best Practices for Performing an Engine Upgrade” in the Interplay ReadMe on the Avid Knowledge Base. For details on backing up your database, see the Interplay | Engine and Interplay | Archive Engine Administration Guide.

- Avid recommends that before upgrading Interplay Production components, use the operating system to manually uninstall the installed components, except for the Interplay Engine or the Interplay Archive Engine. Then use the Interplay Production installer, as described in this document.

  When uninstalling the Production Services Engine, preserve SQL and the SQL database

- Do not uninstall the Interplay Engine or Interplay Archive Engine software unless instructed by Avid support. Uninstalling the software could require additional steps to reactivate your database. When upgrading, the installation software takes care of removing the previous version of the software.

Installation Check List

The following check list provides an overall view of an Interplay installation.
<table>
<thead>
<tr>
<th>Task</th>
<th>Section Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check your network environment.</td>
<td>See “Network Considerations” on page 15.</td>
</tr>
<tr>
<td>Set up and configure your Avid ISIS or Avid NEXIS system.</td>
<td>See “Set Up and Configure an Avid Shared-Storage System” on page 16 and “User Names and Passwords Required For Avid Shared Storage and Product Servers” on page 16.</td>
</tr>
<tr>
<td>Determine where the Avid Lookup Service is running or where it will run. The Lookup service is part of the Avid Service Framework.</td>
<td>See “Installing the Lookup Service on a Separate Server” on page 77, and “Connecting Systems Directly to the Lookup Service” on page 79.</td>
</tr>
<tr>
<td>If you use an AirSpeed 5000/5500 system, refer to the associated installation guides.</td>
<td>See the Avid AirSpeed 5000/AirSpeed 5500 Setup Guide.</td>
</tr>
<tr>
<td>If you are using Production Services providers such as Interplay Transcode or Interplay Archive, determine where your Interplay Production Services Engine server will reside and where you Production Services providers will reside.</td>
<td>See the Interplay</td>
</tr>
</tbody>
</table>
| Set up the servers that will be used in your Interplay environment. | • For specific server support, see “Interplay Production Server and Operating System Support,” which is available on the Avid Knowledge Base: http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts  
• For Dell and HP servers, see “Interplay | Production Dell and HP Server Support,” which is available on the Avid Knowledge Base, on the landing page for each Interplay Production version: http://avid.force.com/pkb/articles/en_US/readme/Avid-Interplay-Production-Documentation  
• Also see: - “Interplay | Production and Related Products Port Usage” on page 103  

*Starting with Interplay v3.5, streaming playback through the Streaming Server is no longer supported in Interplay Access. The Interplay Streaming Server is not used for Interplay v3.5.* |
| If you will be setting up a cluster (failover) configuration of the Interplay Engine or Interplay Archive Engine, set up hardware for the cluster system. | See http://resources.avid.com/SupportFiles/attach/Failover_Guide_Interplay_v2018_11.pdf. |
## Check List for Installing Interplay Components

<table>
<thead>
<tr>
<th>Task</th>
<th>Section Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Server Execution User account for the Interplay Engine.</td>
<td>See “Creating the Server Execution User Account” on page 17.</td>
</tr>
<tr>
<td>Install and configure the Media Indexers that will monitor shared storage.</td>
<td>See “Working with Media Indexers v3.5 and Later” in the Interplay Best Practices Guide. See “Working with Interplay</td>
</tr>
<tr>
<td>At this point you can install and configure the following applications in any order:</td>
<td></td>
</tr>
<tr>
<td>• Install the Interplay software components for the Avid editing applications.</td>
<td>See “Installing Software on Avid Editing Systems (Windows)” on page 43.</td>
</tr>
<tr>
<td>• Install and configure the Production Services Engine.</td>
<td>See “Installing Software on the Production Services and Production Services Provider Servers” on page 26.</td>
</tr>
<tr>
<td>• Install and configure servers for Production Services such the Copy Provider server.</td>
<td>See “Installing Software on the Production Services and Production Services Provider Servers” on page 26.</td>
</tr>
<tr>
<td>• Install and configure Interplay Capture.</td>
<td>See the following Interplay</td>
</tr>
<tr>
<td>• Install and configure the Archive Engine. This is similar to installing and configuring an Interplay Engine as described earlier in this section.</td>
<td>See “Installing and Configuring an Interplay Archive Engine” on page 58.</td>
</tr>
<tr>
<td>Create the Interplay database.</td>
<td>See “Creating an Interplay Database” in the Interplay</td>
</tr>
<tr>
<td>Create Interplay users and folder structures to match your project workflow and define a delete strategy.</td>
<td>See “Setting up a Folder Structure and a User Database” and “Developing a Delete Strategy” in the Interplay</td>
</tr>
<tr>
<td>Review the shared-storage and Interplay maintenance procedures.</td>
<td>See the Interplay Best Practices Guide.</td>
</tr>
</tbody>
</table>
Network Considerations

This section contains topics related to setting up your Interplay network environment.

For more information, see the following pages on the Avid Knowledge Base:


Computer Names

A hostname must comply with RFC 952 standards. For example, you cannot use an underscore in a hostname. For more information, see “Naming Conventions in Active Directory for Computers, Domains, Sites, and OUs” on the Microsoft® Support Knowledge Base. See also “Shared-Storage Workspace Names” on page 16.

Verify Entries on the DNS Server

Service Framework can become sluggish and unstable if there are incorrect entries in the DNS server for any of the computers in the Interplay environment. Symptoms include excessive CPU usage by the Service Framework Lookup service and Interplay Diagnostics. The tree view in the Interplay Service Configuration or Health Monitor might also fail to populate if there are incorrect DNS entries.

Make sure that you correct any errors in DNS entries for name to IP resolution.

Configure the DNS Server to Support Reverse Lookup

If DNS is not configured for Reverse Lookup, Service Framework cannot resolve IP addresses to host names. Symptoms include tree views failing to populate in the Interplay Service Configuration, Interplay Diagnostics, and Health Monitor.

Make sure the DNS server is configured to support Reverse Lookups.

Non-DNS Environments

In an non-DNS environment, you must configure a host file on all systems. This is necessary so the Service Framework can list the systems in its client applications, such as the Interplay Service Configuration or Health Monitor.

Computers with Multiple Network Interfaces

Computers that have multiple network interfaces in use must be entered in DNS so that all IP addresses have the exact same hostname.

If you have multiple network interfaces on a computer and one is not used, use the Device Manager to disable the interface. If not, the computer might have problems communicating with the rest of the Interplay workgroup.

If a server has multiple network interfaces enabled across different VLANs, ensure that all interfaces are fully routable to each other. Verifying communication between each network is critical to the success of the Avid Interplay Framework and other Avid services.
Know Where Your Subnets Are on the Network

Create a system diagram that identifies the subnets on your Interplay Production environment. Use Unicast Discovery to allow Interplay clients to communicate across subnets. See “Connecting Systems Directly to the Lookup Service” on page 79.

*The Multicast Repeater service is available on the Avid Service Framework installer but the service is no longer recommended. Use Unicast Discovery instead.*

Install Antivirus Software and Check Firewalls

See “Using Antivirus Software in an Interplay | Production Environment” on page 72 and Troubleshooting Firewalls and Interplay | Production.

Time Synchronization

It is important to use only one time synchronism mechanism to set the local PC clocks in the Interplay environment. For more information on Time Sync, see “Using Time Synchronization in an Interplay | Production Environment” on page 75.

Set Up and Configure an Avid Shared-Storage System

Before you install Interplay software, install and configure your Avid shared-storage system. Install the ISIS or Avid NEXIS Client Manager on the client systems.

For the versions of Avid ISIS or Avid NEXIS that are supported Interplay Production releases, see the Avid Knowledge Base article “Avid Video Compatibility Charts.”

For information on configuring third party (3rd party) storage systems, see the *Interplay Best Practices Guide*.

Shared-Storage Workspace Names

Use the following guidelines when creating shared-storage workspace names in an Interplay environment:

- Do not use special characters or spaces in your workspace names. Workspace names should only contain ASCII characters.
- Keep workspace name length as short as is reasonable to allow recognition of the workspace. Longer workspace names add to the path length and can affect performance in a large Interplay environment.

User Names and Passwords Required For Avid Shared Storage and Product Servers

Some Avid products require user accounts on the Avid shared-storage system. The user names and passwords on the Avid shared-storage system must match the user names and passwords on the product server.

*Passwords are case sensitive; the passwords must match exactly.*
The following topics provide information about required user accounts:

- “Creating the Server Execution User Account” on page 17
- “Accounts for Accessing Workspaces through the Interplay Administrator” on page 17
- “Accounts for Using Deletion” on page 18
- “Accounts for Using Interplay Transfer” on page 18
- “Service Framework Administrator Password” on page 18
- “Accounts for Avid Editing Applications and Interplay Assist” on page 18

Also see “Creating Copy Provider User Accounts for Shared Storage and Interplay Production” on page 93

**Creating the Server Execution User Account**

When you install the Interplay Engine software you must specify the user name and password of the Server Execution User account. The Server Execution User is a Windows operating system user account that is used only to run the Interplay Engine processes. See “Installing the Interplay Engine Software” on page 21 and the Interplay Engine and Interplay Archive Engine Administration Guide.

⚠️ When you install the Interplay Engine or the Interplay Archive Engine, do not select the default Server Execution User. Create a custom user instead. The default user account is AVID_WORKGROUP_USER. Do not use this account.

**Accounts for Accessing Workspaces through the Interplay Administrator**

To allow the Interplay Engine to access the Avid shared-storage workspaces, you need to set up user accounts on both the Interplay Engine and the Avid shared-storage system. The user name and password for these user accounts must match exactly on both the Interplay Engine and Avid shared-storage system. If the user names or passwords are different, the workspaces are not available in Interplay Administrator settings, such as the Media Creation workspace in the Editor Settings tab of the Application Database Settings.

The workspaces available from the Interplay Administrator settings depends on the user account used to log in to the Interplay Administrator. For example, when you log in to the Interplay Administrator server using the Administrator account, you can access all the Avid shared-storage workspaces, provided the users are set up correctly on both the Interplay Engine and Avid shared-storage system.

**To access all workspaces:**

1. Make sure the Administrator account on both the Interplay Engine and Avid shared-storage system have exactly the same password. Passwords are case sensitive.
2. Log in to the Interplay Administrator server using the Administrator account.

**To access a limited list of workspaces:**

1. Make sure a user account with administrator privileges is created on the Interplay Engine and the same user name and password are used to create a user account on the Avid shared-storage system. These user accounts must have exactly the same user name and password.
2. Log in to the Interplay Administrator server using this user account.

The Avid shared-storage user’s workspace access privileges setting determine which workspaces are available.
Accounts for Using Deletion

To allow deletion in an Interplay environment, you must set up the following user accounts. You can use any user name and password for these accounts, but the user name and passwords must match exactly on all servers.

- **Avid shared-storage system**
  - Avid shared-storage user with administrator privileges for Interplay Engine. This user must *not* be the Administrator account.

- **Interplay Engine server**
  - Microsoft Windows user with administrator privileges
  - Interplay Engine Server Execution User

  When installing the Interplay Engine on the Interplay Engine server, select the Custom User Account option to create the Interplay Engine Execution User. The Server Execution User is the Microsoft Windows user that runs the Interplay Engine (the Interplay Engine Execution User). This user needs to have administrative access to the file server. The installer makes this user a local administrator on the Interplay Engine server. For more information, see “Creating the Server Execution User Account” on page 17.

Accounts for Using Interplay Transfer

When you are configuring an Interplay Transfer Engine you must specify a user name and password that Interplay Transfer should use to connect to the Interplay engine. This user account must already exist on the Interplay Engine.

Service Framework Administrator Password

By default the Service Framework does not have an Administrator password. If you want to set a password, open the Service Framework Service Configuration tool and set the password in the System Configuration Service.

**To set the Service Framework password:**

1. Open the Service Configuration tool and click the Processes tab.
2. Select the System Configuration service and select the system running the System Configuration service.
3. Set the Administrator password and click Apply at the top of the dialog box.

Accounts for Avid Editing Applications and Interplay Assist

The following limitations exist for editing clients in an Interplay environment:

- **Avid editing applications such as NewsCutter® and Media Composer®, and Symphony™ Nitris®** that are part of an Interplay environment can use a regular Windows User login. However, when you install the application, you must first log in as an Administrator, install the application, and initially launch the application as an Administrator. See the Avid editing application ReadMe for details.

- When you install Interplay Assist, you must first log in as an Administrator, install the application, and initially launch the application as an Administrator. You can then subsequently run the application as a regular User.
See “User Names and Passwords Required For Avid Shared Storage and Product Servers” on page 16. Check the Interplay ReadMe for any changes to the Windows login permissions.
2 Installing Software on Interplay Servers

The following topics describe the installations of the Interplay software on the servers:

- Starting the Interplay Server Installer
- Installing Software on the Interplay Engine Server
- Installing Software on the Interplay | Transfer Server
- Installing Software on the Production Services and Production Services Provider Servers
- Installing Software for Interplay Web Services
- Installing the MediaCentral Distribution Service

For information on the order of installation and configuration, see “Installation Check List” on page 12.

For information on installing Media Indexer, see “Installing Software on Media Indexer Servers” on page 35.

Beginning with Interplay v3.5, the Interplay Streaming Server and playback in Interplay Access are no longer supported.

Starting the Interplay Server Installer

To start the Interplay Server Installer:

1. In the Interplay Server Installer folder, double-click autorun.exe.
   The Main Menu window opens.
Installing Software on the Interplay Engine Server

The Main Menu window allows you to select the installers required by a particular Interplay component. The list is divided into Interplay servers, individual optional installers, and Interplay SDKs.

Items with three dots open a new window. Items without three dots start an installer.

Installing Software on the Interplay Engine Server

These instructions are for a system with a single Interplay Engine or Interplay Archive Engine. For specific information about an Interplay Archive Engine, see “Installing and Configuring an Interplay Archive Engine” on page 58. If you are installing software on a system with cluster services, see the Interplay | Engine Failover Guide for Windows Server 2012.

If you are upgrading an Interplay Engine, see the Interplay | Production ReadMe before proceeding. The Readme contains any specific instructions for upgrade the Interplay Engine for a particular release.

To install the Interplay Engine Server:

1. Select the following from the Interplay Server Installer Main Menu:
   - Servers > Interplay Engine
2. Install components from the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine</td>
<td>The full Interplay Engine software. See “Installing the Interplay</td>
</tr>
<tr>
<td>Access</td>
<td>Required to communicate with the Interplay Engine database. Installing Interplay Access also installs the Interplay Administrator. See “Installing Interplay</td>
</tr>
<tr>
<td>Nexis client</td>
<td>Install the latest Nexis client as recommended in the MediaCentral compatibility matrix: <a href="http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf">http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf</a></td>
</tr>
</tbody>
</table>

Installing the Interplay | Engine Software

If you are installing or upgrading a cluster system, see the Interplay Production ReadMe and the Interplay | Engine Failover Guide for Windows Server 2012.

If you are installing an Interplay Archive Engine, see “Installing and Configuring an Interplay Archive Engine” on page 58.

To install the Avid Interplay Engine:

1. Before you begin, do the following:
   - If the server is currently using an application key (dongle), make sure it is installed on the server system. For new installations of Interplay Engine software, install a software license after installing the Interplay Engine software, as described at the end of this procedure.
Make sure you have created matching accounts on the Interplay Engine system and the Avid shared storage system. You need to type the user name and password during installation to create the Server Execution User. See “Creating the Server Execution User Account” on page 17.

2. Close all other applications before proceeding with the installation.

3. Download and unzip the MediaCentral Production Management installer from the Avid Download Center.

4. Launch the Avid Interplay installer by double-clicking autorun.exe.
   A start screen appears that provides you with options to install multiple products.

5. Select the following from the Interplay Server Installer Main Menu:
   Servers > Interplay Engine > Interplay Engine

If you are installing MediaCentral Production Management v2018.11 or later on Windows Server 2012, the installer prompts you to install one or more prerequisite Windows components. Follow the prompts to install these prerequisites and reboot the server when prompted.

The installer opens a new PowerShell command window and displays the Production Management Engine Installer Welcome screen. During the installation, the command window displays information about the installation process.

Avoid marking (highlighting) any text in the PowerShell command window. If you mark any text in this window, you will pause the installation process. If you accidentally mark text, you must click once anywhere inside the command window to resume the installation.

6. In the Welcome dialog box, read the information about the installation of the Apache server.
   Click Next.

The License Agreement dialog box opens.
7. Read the license agreement and click Accept to continue.

8. The installer prompts you to specify the path in which to install the Production software. Accept the default path and click Next.
   The default path is: C:\Program Files\Avid\Production Management Engine

9. Type the name of the Server Execution User used to run the Avid Interplay Engine, and then click Next.
   For example: nxnuser
   The Server Execution User is the Windows user that runs the Interplay Engine. This account is automatically added to the Local Administrators group on the server.

10. Type the password for the Server Execution User specified above and click Next.

11. Retype the password for the Server Execution User account and click Next.
   The Production installer verifies that this password matches the password that you entered in the previous step. If it does not match, you are returned to the previous step where you must enter and reconfirm your password again.

12. The installer prompts you to specify the path for the Production database. Accept the default path and click Next.
   The database folder is the folder in which the database is created and stored. This location must be local, that is, the database folder must be installed on the Interplay Engine server. No other configuration is supported. By default the database folder is created at the root of the D: drive as D:\Workgroup_Databases. All access rights are set automatically.

13. The installer asks if you want to enable the Interplay SNMP (Simple Network Management Protocol) service.
   - If you do not need to enable SNMP, keep the default selection of No and click Next.
   - If you need to enable SNMP, click the Yes button and click Next.
     The installer verifies that the local SNMP service is installed on the engine. The installer does not verify that the SNMP service is configured or running, only that it is installed. If you click Yes and Windows SNMP is not installed, a second window appears to confirm that you still wish to install the Interplay SNMP service.
     For more information on configuring Production Management with SNMP, contact Avid Customer Care.

14. The installer asks if you want to install the Sentinel USB Dongle Driver.
   - If your Production Engine is licensed using a software license only (no dongle), keep the default selection of No and click Next.
   - If your Production Engine is licensed using USB dongles that are attached directly to each Production Engine, click the Yes button and click Next.
     The USB driver is installed automatically for you during the Production Engine installation process.

15. The installer presents a confirmation window that details the information that you specified in the steps above.
   - If you see an error, click the Cancel button to exit the installer.
     In this case, you must restart the installation process from the beginning.
   - If the information is correct, click the Start button to begin the installation process.
As shown in the following illustration, the PowerShell command window that was opened when you first initiated the installation process begins to provide feedback about the installation tasks.

If you see any errors during the installation process, you can review the logs under `<drive>\<path to Production installer>\Engineinstaller\Logs` for more information.

If the system displays the following warning message, you can ignore the message and continue with the installation.

**WARNING:** The properties were stored, but not all changes will take effect until Avid Workgroup Disk is taken offline and then online again.

16. At the end of the installation process, you should see an “Installation finished” message as in the following illustration.
Click inside the command window and press any key to close the window.

17. Enable a permanent license key.

   If you use an application key for licensing your server, make sure that you obtain and load the Interplay Engine license file promptly. The permanent license key must match the application key (dongle) for the Interplay Engine server. See “Managing Licenses” in the Interplay | Engine and Avid Archive Engine Administration Guide for instructions.

   If you use a software license, see the procedures described in “Software Licensing for Interplay Production” on page 61.

**Identifying the Central Configuration Server**

The Central Configuration Server (CCS) is an Interplay Engine with a special module that is useful if you are working in an environment that includes more than one Interplay Engine (including an Interplay Archive Engine). The CCS uses this module to store information that is common to all other Interplay Engines. Cross-database management of administrative tasks is possible because all of the Interplay Engines under the CCS inherit its settings by default. A Central Configuration Server is especially useful for user management tasks.

The Interplay 2018.11 (and greater) installer does not specify the CCS. If you have more than one Interplay Engine, use the Interplay Administrator tool to identify the CCS. See “Understanding the Central Configuration Server” in the Interplay | Engine and Interplay | Archive Engine Administration Guide on the Avid Knowledge Base.

**Installing Interplay | Access**

You must install Interplay Access on the Interplay Engine. Avid recommends that you accept the defaults.

Installing Interplay Access also installs the Interplay Administrator.
To install Interplay Access:
1. Select the following from the Interplay Server Installer Main Menu:
   Servers > Interplay Engine > Access
   After the installer starts, the Introduction dialog box opens.
2. Close down all other programs, then click Next.
3. Complete the installation by accepting the defaults.
4. When you finish the installation, the installation program might require you to reboot the system.

Installing Software on the Interplay | Transfer Server

To install Interplay software on the Interplay Transfer server:
1. Select the following from the Interplay Server Installer Main Menu:
   Servers > Transfer Engine
2. Install components from the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications.</td>
</tr>
<tr>
<td>Transfer Engine</td>
<td>For details on installing and configuring the Interplay Transfer server and the Interplay Production Services and Transfer Status application, see the Interplay</td>
</tr>
<tr>
<td>Production Services and Transfer Status (Option)</td>
<td>Lets you monitor Interplay Transfer jobs as well as Interplay Production Services jobs from any computer in the network.</td>
</tr>
<tr>
<td>Transfer Cache (Option)</td>
<td>Lets you install only the Interplay Transfer Cache. The Transfer Cache Engine runs in the background and allows you to monitor transfers in the workgroup.</td>
</tr>
</tbody>
</table>

Installing Software on the Production Services and Production Services Provider Servers

The following topics provide information about installing the Production Services and Production Services Provider servers:

- “Installing the Production Services Engine” on page 27
- “One-Time Configuration for Production Services Engine Upgrade” on page 28
- “Installing the Local Workflow Components” on page 28
- “Installing the WAN Workflow Components” on page 32
- “Installing the Media | Index Components” on page 33

The following illustration shows the initial installer screen.
Installing Software on the Production Services and Production Services Provider Servers

Installing the Production Services Engine

Use the Production Services screen to install software for the Production Services Engine.

**Support for SQL Server 2016:** The Production Services Engine installer includes SQL Server 2016.

- For new installations, SQL Server 2016 is automatically installed.
- For upgrades, SQL Server 2012 is preserved. SQL Server 2016 is not installed.

Avid recommends backing up your SQL database before upgrading. For more information, see the Production Services Setup and User’s Guide.

⚠️ **If you are upgrading the Production Services Engine, during the installation, select “Upgrade existing database” (the default). Do not select “Overwrite current database.” This option causes the following error message to be displayed: “Error 27506. Error executing SQL script dmsdb.sql.” After you click OK, the installer fails. Either begin the installation again and select “Upgrade existing database” or perform a new clean installation.**

**To install the Interplay Production Services Engine:**

1. Select the following from the Interplay Server Installer Main Menu:
   Servers > Production Services > Production Services
   The Install Production Services window opens.

2. Install components from the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Framework</td>
<td>Select the Framework installer. This is an installer for 64-bit systems.</td>
</tr>
<tr>
<td>for Client</td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications.</td>
</tr>
<tr>
<td></td>
<td>Required software to configure the Production Services Engine with the Interplay server.</td>
</tr>
</tbody>
</table>
3. Install a license for the Interplay Production Services Engine.

For Interplay Production v3.4 and later, if you plan to install only the Production Services Engine on this server, you need to install a standalone software license. If you plan to install a Production Services provider on the same server, a separate license is not required for the Production Services Engine. See “Activating a Single License” on page 64.

If the server is currently using an application key (dongle), make sure it is installed on the server system.

4. Configure the Production Services Engine for the Interplay workgroup. See the Interplay | Production Services Setup and User’s Guide.

   If you are performing an upgrade, you do not have to reregister existing services such as the Transcode service or Archive service or existing providers.

One-Time Configuration for Production Services Engine Upgrade

As a result of the change of the Production Services Engine to a Windows service, the location of the settings file has also changed. If you are upgrading to the Production Services Engine v3.7 or later, you need to open and save the Settings dialog box to transfer the settings to the new location.

   If you do not open and save your settings in the new location, the default values are used. The default values do not include the Interplay Engine name. If no Interplay Engine is specified, user logins are checked against the Production Services user database, not the Interplay Engine user database. Depending on your user configuration, this could prevent Production Services tasks from running.

To transfer Production Services settings:

1. After you install the Production Services Engine v3.7, select Programs > Avid > Interplay Production Services Engine Configuration.

2. In the Interplay Production Services Configurator dialog box, click the Settings button.

   The Settings dialog box opens. If you are upgrading, the dialog box retains your settings.

3. Click OK.

   Clicking OK saves your settings in the new location.

4. Close the Interplay Production Services Engine Configurator dialog box.

Installing the Local Workflow Components

Use the Install Local Workflow Support screen to install the local workflow providers and other components.
To install the Local Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay Server Installer Main Menu.

   Servers > Production Services > Install Local Workflow Support

   The Install Avid Interplay Production Services Local Workflow window opens.

2. Select the service provider or component that you want to install.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications.</td>
</tr>
<tr>
<td></td>
<td>Recommended for installation on each provider.</td>
</tr>
<tr>
<td>Transcode</td>
<td>The Transcode service provider. Allows you to define profiles and launch transcode jobs from Access or the Avid editing application.</td>
</tr>
<tr>
<td></td>
<td>The Interplay Transcode installer includes an option in which you select whether you want to mount workspaces as drive letters or UNC paths. Select UNC paths if the number of workspaces required for the client exceeds the available drive letters. Change the server's shared-storage Client Manager preferences match the setting you choose.</td>
</tr>
<tr>
<td></td>
<td>The Interplay Transcode installer includes an option that lets you select the number of instances of the Transcode provider that you want to install. See “Installing Multiple Transcode Providers on the Same Server” on page 30.</td>
</tr>
<tr>
<td>STP Encode</td>
<td>Allows you to off load time-consuming processing involved in exporting and transferring of Long GOP OP1a media, during a send-to-playback request from an Avid editing application or Interplay Assist.</td>
</tr>
<tr>
<td></td>
<td>Do not install STP Encode and Interplay Transcode providers on the same system.</td>
</tr>
<tr>
<td></td>
<td>The Interplay STP Encode installer includes an option in which you select whether you want to mount workspaces as drive letters or UNC paths. Select UNC paths if the number of workspaces required for the client exceeds the available drive letters. Change the server's shared-storage Client Manager preferences match the setting you choose.</td>
</tr>
<tr>
<td>Archive</td>
<td>The Archive provider. Typically installed on its own server. See “Installing the Interplay Archive Provider Software” on page 59.</td>
</tr>
<tr>
<td>Copy</td>
<td>The Interplay Copy provider. Typically installed on its own server. See “Configuring the Copy Provider Server” on page 92.</td>
</tr>
<tr>
<td>Move</td>
<td>Allows you to move media for Avid assets (both .mxf and .omf files) from one shared-storage workspace to another.</td>
</tr>
<tr>
<td>Production Services and Transfer Status</td>
<td>Lets you monitor Interplay Transfer jobs as well as Interplay Production Services jobs on a standalone system. You don’t need to install this software on the Production Services system as the function is built into the Production Services Engine software.</td>
</tr>
<tr>
<td>Auto Production Services (Optional)</td>
<td>Installs the Interplay Auto Production Services. This installation includes the Auto Archive, Auto Transcode, Auto Transfer, and Auto Copy services.</td>
</tr>
</tbody>
</table>
3. After installing the software, you need to activate a license for the following services:
   - Transcode
   - Archive
   - Copy
   - Move

   See “Activating a Single License” on page 64.

4. After installing the software and activating a license (if applicable), you need to register and configure the providers. See the Interplay | Production Services Setup and User’s Guide.

### Installing Multiple Transcode Providers on the Same Server

Interplay Transcode v3.0 and later is qualified to run as multiple instances on the same server. Up to four providers are supported, depending on the total amount of CPU used.

#### Determining the Number of Providers to Install

To determine the optimum number of providers to install on a server, check the system resources currently used for your Transcode workflows. Open the Task Manager and click the Performance tab to display information about CPU usage. When jobs typical to your workflow are running, note the average percentage of CPU used. The following illustration shows a Transcode job in process that is using 14 percent of the CPU.

Use the formula \( \frac{100}{\text{CPU Usage Percentage}} \) to estimate the number of providers you can use. For example, if the average CPU usage is 25 percent, you can use four Transcode providers on the server. The maximum number of providers supported on a single server is four.

> Complex mixdowns require much more memory than transcoding. If your workflow involves complex mixdowns you should install a maximum of two providers on the same server.
Installing Software on the Production Services and Production Services Provider Servers

Requirements

- A qualified server with a minimum of 12 GB of RAM
  Memory requirements for Interplay Transcode increased in v3.3. If you are running multiple instances of Interplay Transcode on the same system, compare the RAM requirements of Transcode to the RAM of the system. For example, four instances of Transcode might require greater than 12 GB of RAM.
- License and either an application key (dongle) or software license for multiple Transcode providers.
  Starting with Interplay Transcode v3.0.5, an Interplay Transcode license can include support for multiple Transcode providers on a single system.

Installation

The Interplay Transcode installation program includes an option that lets you select the number of instances of the Transcode provider that you want to install. Select the number of transcode providers specified in your software license or dongle.

![Installation Program Screenshot]

The installation program installs executable files for the number of providers you selected, named DMSTranscode.exe, DMSTranscode 2.exe, and so on. It also installs one Service Description file (.zip file).

For information on activating a software license, see “Software Licensing for Interplay Production” on page 61.

For information on configuring providers, see the Interplay / Production Services Guide or the Interplay Help. Use a different name for each provider.

Using the Providers

After you configure each provider, you can create profiles and send jobs as you would for providers that are on individual servers.
Installing Avid Service Framework for Local Workflow Components

All local workflow components require the 64-bit version of Avid Service Framework for Client.

To install the Framework for the local workflow components:
1. Navigate to the following installer page:
   Servers > Production Services > Production Services

Installing the WAN Workflow Components

Use this installer screen to install the WAN workflow providers. The Delivery service provider and the Delivery Receiver service allow you to transfer clips, shotlists, and cuts only sequences and the media files to another workgroup.

To install the Production Services WAN Workflow Components:
1. On the system that you want to install the provider, select the following from the Interplay Server Installer Main Menu:
   Servers > Production Services > Install WAN Workflow Support
   The Install Production Services WAN Workflow window opens.
2. Select the service provider that you want to install.
3. After installing the software, you need to activate a license for the Delivery service.
   See “Activating a Single License” on page 64.
4. After activating a license (if applicable), you need to register and configure the providers. See the Interplay / Production Services Setup and User’s Guide.

   For information on the Delivery and Delivery Receiver providers, see the Interplay / Production Services Setup and User’s Guide.

Installing Avid Service Framework for WAN Workflow Components

Interplay Delivery and Interplay Delivery Receiver require the 64-bit version of Avid Service Framework for Client:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery</td>
<td>The Interplay Delivery service provider. The Delivery service provider and the Delivery Receiver service allow you to transfer clips, shotlists, and cuts only sequences and the media files to another workgroup. You can also use profiles to only transfer the portion that is used in a subclip.</td>
</tr>
<tr>
<td>Delivery Receiver</td>
<td>The Interplay Delivery Receiver service. The Delivery Receiver service lets the workgroup receive transfers from a workgroup with the Delivery service.</td>
</tr>
<tr>
<td>Dynamic Relinker</td>
<td>For use with Media Composer Cloud. For more information, see the Media Composer</td>
</tr>
</tbody>
</table>
To install the Framework for the WAN Workflow Components:

1. Navigate to the following installer page:
   
   Servers > Production Services > Production Services


Installing the Media | Index Components

Use this installer screen to install Production Services providers that are used in MediaCentral workflows. Media Index runs on the MediaCentral Platform and provides a central index for multiple Interplay Production databases. The Production Services Automation provider and the Consolidate provider work together to deliver assets and media that a user finds through a search of the central index. For more information, see the *Avid MediaCentral Platform Services Installation and Configuration Guide*.

To install the Media Index components:

1. On the system that you want to install the provider, select the following from the Interplay Server Installer Main Menu:
   
   Servers > Production Services > Install Media | Index Support

   The Install Media | Index Support window opens.

2. Select the service provider that you want to install.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production Services</td>
<td>This service handles the logic of chaining a consolidate job and a delivery</td>
</tr>
<tr>
<td>Automation</td>
<td>job. It triggers a consolidate job and monitors its status. If the</td>
</tr>
<tr>
<td></td>
<td>consolidate job is successful, it triggers a delivery job.</td>
</tr>
<tr>
<td>Consolidate</td>
<td>This service uses the In and Out marks specified for a loaded clip or</td>
</tr>
<tr>
<td></td>
<td>subclip to create a new media and asset.</td>
</tr>
</tbody>
</table>

These services do not require a license.

Installing Avid Service Framework for Media | Index Components

Interplay Production Services Automation and Interplay Consolidate require the 64-bit version of Avid Service Framework for Client:

To install the Framework for the Media Index components:

1. Navigate to the following installer page:
   
   Servers > Production Services > Production Services


Installing Software for Interplay Web Services

The Interplay Web Services SDK provides third parties with a rich set of functions to integrate tightly with an Interplay environment. For more information, read the documentation that is installed with the SDK.
Before installing Interplay Web Services, install and configure the Avid Service Framework.

To install the Avid Service Framework:
1. Select the following from the Interplay Server Installer Main Menu:
   Individual Optional Installers > Service Framework
   After the installer starts, the Introduction dialog box opens.
2. Click Next and follow the installation instructions.

To install Interplay Web Services
1. Select the following from the Interplay Server Installer Main Menu:
   Interplay SDKs > Web Services
   After the installer starts, the Introduction dialog box opens.
2. Accept the license agreement and follow the installation instructions.

Installing the MediaCentral Distribution Service

The Avid MediaCentral Distribution Service (MCDS) coordinates and monitors send-to-playback and mixdown operations for MediaCentral UX. It determines if there is any preprocessing required. If it determines an audio mixdown is required, it submits a Transcode Mixdown request. If Long GOP media is required, it submits an STP Encode request. You can configure your workgroup for more than one MCDS.

For more information, see the Avid MediaCentral Platform Services Installation and Configuration Guide.

To install the MediaCentral Central Distribution Service:
1. Open the Installers folder at the top level of the Servers installation media.
2. Open the MediaCentralDistribution folder.
3. Double-click setup.exe.
4. Follow the installation instructions.
3 Installing Software on Media Indexer Servers

The following topics describe installing Interplay Media Indexer on a server:

- Media Indexer Memory and Disk Space Requirements
- Media Indexer Server Installation Requirements
- Installing Media Indexer on a New Server
- Upgrading Media Indexer Servers
- Upgrading Media Indexer on an Interplay Bundle
- Media Indexer Installer Log
- Check that Media Indexer is Done Indexing
- Media Indexer Memory Management on an Interplay Bundle

For information on installing Media Indexer on editing systems, see the following sections in the chapter on installing software on Interplay Production clients:

- “Installing Software on Avid Editing Systems (Windows)” on page 43
- “Installing Software on Avid Editing Systems (Macintosh)” on page 45

For information on configuring and using Media Indexer, see the Interplay Best Practices Guide.

Media Indexer Memory and Disk Space Requirements

Virtualization (VM) Requirements

For information on the number of vCPUs and RAM recommended for Media Indexer, see the Interplay Production Virtual Environment with VMWare Best Practices Guide on the Avid Knowledge Base.

Memory Requirements

Minimum memory requirements have increased for Media Indexer v3.6.x and later to 32GB minimum. The following table lists the memory requirements:

<table>
<thead>
<tr>
<th>Hardware Platform</th>
<th>Operating System</th>
<th>RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell R630</td>
<td>Windows Server 2012 Standard R2</td>
<td>32GB minimum</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2016 Standard</td>
<td></td>
</tr>
<tr>
<td>HP Proliant DL360 Gen9</td>
<td>Windows Server 2012 Standard R2</td>
<td>32 GB minimum</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2016 Standard</td>
<td></td>
</tr>
</tbody>
</table>
Disk Space Requirements

A Media Indexer server only requires a C: partition. However, Media Indexer servers are often configured with a D: partition for storing installers and backup log files. Because the MongoDB database stores its documents on the C: partition, it is good to allocate as much space as possible for the C: partition.

In addition, Media Indexer can save logs with a lot of data, especially when set to finer logging levels for troubleshooting. If you are setting up a new server, allocate at least half the available space for the C: partition.

Media Indexer Server Installation Requirements

The following sections describe how to install Media Indexer v3.6.x and later on supported servers.

Before Installing Media Indexer Software

The following are important for a successful Media Indexer configuration:

- Before you configure Media Indexer to monitor your Avid shared-storage workspaces, the workspaces must have an Avid MediaFiles folder. To create the folder, you can either use an Avid editing application to capture or import media to the workspace or you can manually create an Avid MediaFiles folder.
- Do not use spaces or special characters in your workspace names.

Using UNC Drive Mapping for Shared-Storage

For a Media Indexer that monitors ISIS or Avid NEXIS shared storage, you must select the “Use UNC (Letterless) Drive Mapping” option in the Client Manager that is installed on the Media Indexer server.

To set UNC Drive Mapping in the Client Manager:

- In the Client Manager window, select Preferences and select Use UNC (Letterless) Drive Mapping.

For more information, see “Mounting Workspaces as Drives: Lettered versus Letterless” on page 74 and “Installation Check List” on page 12.

Configuring Media Indexer Servers and Clients

Starting at Interplay v3.5, the Avid Service Framework (ASF) is no longer used to make the connection between the Media Indexer servers and the Avid editing applications. For instructions on how to configure Media Indexer servers and clients, see the chapter “Working with Interplay Media Indexers v3.5 and Higher” in the Interplay Best Practices Guide v3.6.

Installing Media Indexer on a New Server

Use the following instructions to install Media Indexer software on a new server.
Avid System Framework (ASF) is no longer used by Media Indexer but it is often installed on all of the Interplay Production servers in a workgroup. The following ASF features can be useful:

- Avid Diagnostics to view log files written in alf format.
- Interplay Time Sync service to keep the system clock in sync. Note that this might not be needed if the system clock is kept in sync using a different method such as NTP. For additional information, see *A Guide to Time Synchronisation for Avid Interplay Systems* on the Avid Knowledge Base. This document provides a guide for synchronizing many Avid products.

*Interplay Access is not required on a Media Indexer server.*

**To install Media Indexer on a new server:**

1. Open the Interplay Server Installer and select the following from the Main Menu: 
   Servers > Media Indexer
2. Follow the installation instructions.
   Note that the Media Indexer service will start automatically upon installation. Media Indexer will recreate and start the Media Indexer MongoDB service upon startup.
3. (Option) Install Avid Service Framework (ASF).
   a. Select the following from the Interplay Server Installer Main Menu: 
      Individual Optional Installers > Service Framework
   b. Follow the installation instructions.
4. Before returning to work on the editors, check that the Media Indexer is done indexing files as described in “Check that Media Indexer is Done Indexing” on page 40.

**Upgrading Media Indexer Servers**

Upgrading a Media Indexer server can take a long time depending on the number of files that it is indexing. If there is a change to the Media Indexer database schema then the cache files must be rebuilt. See “Prebuilding a Media Indexer Cache During an Upgrade” in the *Interplay Best Practices Guide*.

**Upgrading Media Indexer on a Media Indexer Server**

Use the following instructions to upgrade a Media Indexer server to Media Indexer v3.6.x or later.

Avid System Framework (ASF) is no longer used by Media Indexer but it is often installed on all of the Interplay Production servers in a workgroup. The following ASF features can be useful:

- Avid Diagnostics to view log files written in alf format.
- Interplay Time Sync service to keep the system clock in sync. Note that this might not be needed if the system clock is kept in sync using a different method such as NTP. For additional information, see *A Guide to Time Synchronisation for Avid Interplay Systems* on the Avid Knowledge Base. This document provides a guide for synchronizing many Avid products.

*Interplay Access is not required on a Media Indexer server.*
To upgrade Media Indexer on a standalone Media Indexer server:

1. On the Media Indexer server, open the Windows Services dialog and stop the following service:
   - Avid Interplay Media Indexer MongoDB

2. Uninstall the Media Indexer software.
   Note that the MongoDB files will be uninstalled but the system still shows it as registered. So
   you will see the MongoDB service in the MS Services window.

3. Open the Interplay Server Installer and select the following from the Main Menu:
   Server > Media Indexer

4. Install Media Indexer.
   Note that the Media Indexer service will start automatically upon installation. Media Indexer will
   recreate and start the Media Indexer MongoDB service upon startup.

5. (Option) Install Avid Service Framework (ASF).
   a. Select the following from the Interplay Server Installer Main Menu:
      Individual Optional Installers > Service Framework
   b. Follow the installation instructions.

6. Before returning to work on the editors, check that the Media Indexer is done indexing files as
   described in “Check that Media Indexer is Done Indexing” on page 40.

Installing Media Indexer on an Interplay Bundle

This section describes how to install Media Indexer on an Interplay Bundle.

Interplay Bundle System Requirements

The following recommendations apply:
- Maximum Interplay concurrent client count = 30
- Recommended maximum number of data sources loaded into the Media Indexer database = 500,000
- Recommended maximum number of shared-storage workspaces monitored by Media Indexer = 20

The terms client count and data source are described below.

Interplay Client Count

Concurrent client count refers to applications that need to log in and perform asset management
functions such as check in, check out, and search. Concurrent means that this is the number of clients
that can log in and perform tasks at the same time. Interplay clients include applications such as
Media Composer, Media Composer Cloud, MediaCentral, Interplay Access, Interplay Capture,
AirSpeed 5000, Interplay Web Services, Interplay Transfer, and Production Services providers such
as Archive, Delivery, and Transcode.

The current number of connections relevant for an Interplay Bundle configuration is basically the
amount of connections displayed in the Interplay Administrator application. Click Server > Server
Information and check the “Number of Connected Clients”.
Media Indexer Data Source

When determining the number of objects that Media Indexer can load into its database, the term data source is the most accurate term for those objects. A data source can be defined as follows:

- There is usually one data source per mxf file.
- For multitrack audio, there is one data source per audio track in the audio mxf file.
- For AMA media there is one data source per track.

For information on determining the number of data sources currently loaded into an Interplay database, see the Interplay Best Practices Guide.

Media Indexer Memory Management on an Interplay Bundle

Starting at MI v3.8, Media Indexer applies memory restrictions to the Media Indexer and MongoDB Database according to several different profiles. The profiles are automatically determined by whether or not the Media Composer or Interplay Engine are running on the same system as the Media Indexer. This configuration occurs each time the MI service starts. The following table shows the memory allocation for each profile.

<table>
<thead>
<tr>
<th>MI Profile</th>
<th>Profile active when</th>
<th>Media Indexer Process</th>
<th>MongoDM Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows editor</td>
<td>Media Composer is installed</td>
<td>2 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Mac OS X editor</td>
<td>Media Composer is installed</td>
<td>2 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Windows Interplay</td>
<td>Interplay Engine is installed</td>
<td>0.25 * Total memory</td>
<td>0.25 * Total memory</td>
</tr>
<tr>
<td>Bundle</td>
<td>available for Media Indexer</td>
<td>available for MongoDB</td>
<td></td>
</tr>
<tr>
<td>Windows MI server</td>
<td>Neither Media Composer nor Interplay</td>
<td>0.4 * Total memory</td>
<td>0.4 * Total memory</td>
</tr>
<tr>
<td></td>
<td>Engine are installed</td>
<td>available for Media Indexer</td>
<td>available for MongoDB</td>
</tr>
</tbody>
</table>

You do not need to use vmoptions to limit the amount of RAM used on an Interplay Bundle for MI v3.8 or later.

Upgrading Media Indexer on an Interplay Bundle

Use the following instructions to update an Interplay Bundle to Media Indexer v3.6.2 or later. This takes a little longer than a typical patch install but it avoids any system resource conflicts during the installation.

To install Media Indexer:

1. Open the Windows Services dialog and stop the following services:
   - Avid Interplay Media Indexer
   - Avid Interplay Media Indexer MongoDB
   - Avid_Workgroup_Preview_Server
   - Avid Workgroup TCP COM Bridge Service.

   Also change the Startup type of the Workgroup TCP COM Bridge service to Manual so the Engine won’t restart after the first reboot.

2. Navigate to the following folder:
C:\Program Files\Avid\Avid Interplay Engine\Server

3. Execute the command NxNServerShutdown.exe. This will shut down the Interplay Engine.

4. Uninstall the Media Indexer software.
   Note that the MongoDB files will be uninstalled but the system still shows it as registered. So you will see the MongoDB service in the MS Services window.

5. Restart the system.

6. Install Media Indexer.

7. Open the Windows Services dialog and restart the Avid Interplay Media Indexer service.

8. Set the Avid Workgroup TCP COM Bridge Service Startup type to Automatic.

9. Restart the system. The Interplay Engine will automatically restart after the reboot.

10. Start the following services:
    - Avid Interplay Media Indexer
    - Avid Interplay Media Indexer MongoDB

11. Before returning to work on the editors, check that the Media Indexer is done indexing files as described in “Check that Media Indexer is Done Indexing” on page 40.

**Media Indexer Installer Log**

Media Indexer creates an installer log to keep track of the operations occurring during an installation or upgrade.

The log is named MediaIndexer_Install.log. Media Indexer creates the file within the %appdata% directory, which depending on operating system, could be mapped to the following location:

C:\Users\username\AppData\Roaming

where username is the user that executes the installer.

The following limitations apply:

- The log file is first written to (or an exiting one replaced) when the installation wizard is completed.
- The Media Indexer installer loads a number of prerequisite values at the beginning of an installation. The install log will not list the prerequisites.
- Uninstalling the Media Indexer does not remove the log file.

**Check that Media Indexer is Done Indexing**

Before returning to work on the editors, check that the Media Indexer is done indexing files.

**To check that the Media Indexer is done indexing files:**

1. Open the Media Indexer web interfaces in a browser: https://<Media Indexer system name>:8443/mi
2. Open the Statistics tab.
3. Open the four Thread Pool Statistics sections. There are two for the classic MI. The two FI (format independence) windows are for the MongoDB database.

4. When all the queue length values are to 0, then the Media Indexer is done indexing. Note that the queue length values will go up and down during indexing as more subfolders with files are discovered.

*The scanning workers sections on the statistics page are for discovering sub folders. The Indexing worker sections are for indexing files.*
Installing Software on Interplay Clients

The following topics describe the Interplay software installation on Interplay clients:

- Starting the Interplay Client Installer
- Installing Software on Avid Editing Systems (Windows)
- Installing Software on Avid Editing Systems (Macintosh)
- Installing Interplay | Access
- Installing Media Composer | Cloud Components

Starting the Interplay Client Installer

To start the Interplay Client Installer:

1. In the Interplay Client Installer folder, double-click autorun.exe.
   The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay component. The list is divided into Interplay clients and individual optional installers.

*Items with three dots open a new window. Items without three dots start an installer.*
The Interplay Production Client Installer includes a page for installing Interplay components that are required to configure an Avid editing system in an Interplay environment.

You can install Interplay components on Windows systems running the following Avid editing applications:

- Media Composer | Software
- Media Composer | NewsCutter Option
- Media Composer | Symphony Option

These Avid editing applications have their own installers for the Avid editing application software. This section describes how to install components that are required for an Interplay environment.

**To install Interplay components on an Avid editing system (Windows):**

1. Select the following from the Interplay Client Installer Main Menu:
   - Clients > Media Composer Support
2. Install components from the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications. See “Installing Interplay Access on Windows” on page 50.</td>
</tr>
<tr>
<td>Media Indexer</td>
<td>Installs the 64-bit Media Indexer. You configure this Media Indexer to communicate with the Media Indexer monitoring shared storage. For instructions on how to configure Media Indexer servers and clients, see the chapter “Working with Interplay Media Indexers v3.5 and Higher” in the <em>Interplay Best Practices Guide v3.6</em>. You can also configure the Media Indexer to index your local drives. For more information, see “Configuring the Local Media Indexer to Index Local Drives” on page 45.</td>
</tr>
<tr>
<td>Transfer Client (Option)</td>
<td>Installs the 64-bit Interplay Transfer Client. Install this software to take advantage of Interplay Transfer features such as Send to Playback and workgroup to workgroup transfers. For information on configuring the Interplay Transfer client, see the Help for your Avid editing application or the <em>Avid Interplay Transfer Setup and User’s Guide</em>.</td>
</tr>
<tr>
<td>Transfer Engine (Option)</td>
<td>Installs the 64-bit Interplay Standalone Transfer Engine. Use this software to perform workstation to workstation transfers in an environment that does not use shared storage. In this case you install both the Engine and client on the editing system. For information on configuring the Interplay Standalone Transfer Engine and client, see the Help for your Avid editing application or the <em>Avid Interplay Transfer Setup and User’s Guide</em>.</td>
</tr>
</tbody>
</table>

The Avid editing applications must have the shared-storage Client Manager installed and configured to connect to shared storage.
Installing Interplay Transfer on Windows 8 and Windows 10

The Interplay Transfer Client and Interplay Standalone Transfer Engine are supported on Windows 8 and Windows 10. Both Interplay Transfer applications require Microsoft .NET Framework v3.5. Some components of Microsoft .NET Framework 3.5 are automatically installed on these Windows systems, but the feature is not turned on by default. Additional files need to be installed.

**To turn on Microsoft .NET Framework 3.5:**

1. Navigate to Control Panels > Programs > Programs and Features
2. Select .NET Framework 3.5 as shown in the following illustration.

3. Click OK. Reboot your computer if prompted.

*Turning on Microsoft .NET Framework 3.5 requires an Internet connection, otherwise adding the feature will fail. As a workaround, if your server does not have an Internet connection, you can insert a Windows 8 or Windows 10 DVD, select “Specify an alternate source path” in the Feature Installation Confirmation tab, and enter "E:\sources\sxs" path, where E: is the DVD drive. For additional information, see the following article on the Avid Knowledge Base.*

http://support.microsoft.com/kb/2734782/en-us
Connecting the Media Indexer on an Avid Editing System to the Media Indexer Monitoring Shared Storage

For instructions on how to configure Media Indexer servers and clients, see the chapter “Working with Interplay Media Indexers v3.5 and Higher” in the Interplay Best Practices Guide v3.6.

Configuring the Local Media Indexer to Index Local Drives

To instruct Media Indexer to automatically recognize local drives:

1. Start the Avid editing application.
2. Select Tools > Media Creation.
   
   The Media Creation window opens.

3. On the Drive Filtering and Indexing tab, click the “Auto-index local drives as they come online” button.
   
   The local Media Indexer automatically configures Avid media files on your local drives.

   If you don’t want the Media indexer to automatically scan your local drives, deselect the Auto-index option.

4. (Option) Click Manual Storage Scan to start a scan.
5. (Option) Select one of the warning options. The warning occurs if the Media indexer has problems scanning files on the local drive.

Installing Software on Avid Editing Systems (Macintosh)

The Interplay Production Client Installer for Macintosh includes Interplay components that are required to configure an Avid editing system in an Interplay environment.
You can install Interplay components on Macintosh OS X systems running the following Avid editing applications:

- Media Composer | Software
- Media Composer | Symphony Option

These Avid editing applications have their own installers for the Avid editing application software. This section describes how to install components that are required for an Interplay environment.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications. See “Installing Interplay Access on a MacOS X System” on page 50.</td>
</tr>
<tr>
<td>Interplay Transfer</td>
<td>(Option) Install this software to take advantage of Interplay Transfer features such as Send to Playback and workgroup to workgroup transfers. See “Installing Interplay Transfer Client on a Mac OS X System” on page 47. For information on configuring the Interplay Transfer client, see the Help for your Avid editing application or the Avid Interplay Transfer Setup and User’s Guide.</td>
</tr>
<tr>
<td>Media Indexer</td>
<td>Installs the Media Indexer. See “Installing Media Indexer on a MacOS X System” on page 47. After installation, you configure this Media Indexer to communicate with the Media Indexer monitoring shared storage. For instructions on how to configure Media Indexer servers and clients, see the chapter “Working with Interplay Media Indexers v3.5 and Higher” in the Interplay Best Practices Guide v3.6.</td>
</tr>
<tr>
<td>Media Composer Cloud</td>
<td>For information about Media Composer Cloud, see “Installing Media Composer</td>
</tr>
</tbody>
</table>

The Avid editing applications must have the shared-storage Client Manager installed and configured to connect to shared storage.

Note the following:

- Avid editing applications running on Mac OS X systems require drive mapping for any workspaces that you use for reading or writing. For more information, see “Mounting Workspaces as Drives: Lettered versus Letterless” on page 74.
- You cannot use Interplay Production Services from an Avid editing application running on a Mac OS X system. Most Interplay Production Services are available from Interplay Access on a Mac OS X system.

Installing Apple Java on Macintosh Editing Clients

Installation of Apple Java is no longer required on Macintosh editing clients. Installation was required for the following components:

- Interplay Access v3.4.x and earlier
- Interplay Media Indexer v3.6.0 and earlier

For information about installing Apple Java, see earlier versions of this guide.
Installing Media Indexer on a MacOS X System

To install Media Indexer on a Mac OS X system:

1. Open the Interplay Production Clients Installer.
The opening screen is displayed.

2. Double-click Install Media Indexer
   A message asks if you want to continue the installation.
3. Click Continue.
The first screen of the installer program is displayed.
4. Click Continue.
5. When prompted, enter a user name and password for an account that is allowed to install software.
6. When prompted, restart the system.
7. The local Media Indexer will automatically connect to the Media Indexer server after you start the editor and log into Interplay.
   You can also configure the Media Indexer to index your local drives. For more information, see “Configuring the Local Media Indexer to Index Local Drives” on page 45.
   To uninstall Media Indexer, see “Uninstalling Media Indexer from a Mac OS X System” on page 48.

Installing Interplay Transfer Client on a Mac OS X System

To install the Interplay Transfer client on a Mac OS X system:

1. Open the Interplay Production Clients Installer.
The opening screen is displayed.
2. Double-click “Install Interplay Transfer.”
   The first screen of the installer program is displayed.
3. Click Next and continue the installation. When prompted, enter a user name and password for an account that is allowed to install software.
   The following file is installed:
   /Library/Application Support/Avid/xfermgraphi.bundle
   There is no uninstaller for the Transfer Client, so if you need to uninstall the Transfer Client, delete the installed file.

### Uninstalling Media Indexer from a Mac OS X System

To uninstall Media Indexer:

1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X System” on page 49).
2. Open a Terminal window (select Applications > Utilities > Terminal).
3. At the prompt, type the following and press Return:
   ```
   cd /Applications/Avid_Uninstallers/Media\ Indexer
   ```
4. Type the following and press Return:
   ```
   sudo ./AvidMediaIndexerUninstaller.sh
   ```
   Media Indexer is uninstalled.

*If you close the terminal window without uninstalling the program, you can no longer use the terminal window. Workaround: Restart the Macintosh system.*
Stopping and Starting Media Indexer on a MacOS X System

To stop Media Indexer:
1. Open a Terminal window (select Applications > Utilities > Terminal).
2. At the prompt, type the following and press Return:
   ```
   cd /Applications/Avid/MediaIndexer/bin
   ```
3. Type the following and press Return:
   ```
   sudo ./mi.sh remove
   ```
   Media Indexer is stopped. To restart it, type the following and press Return:
   ```
   sudo ./mi.sh install
   ```

Removing Interplay Components from a Mac OS X System

To remove all Interplay components from a MacOS X system, complete the following procedures.

To uninstall Interplay Access:
1. Double-click the following file:
   ```
   ```
2. Click Uninstall.
3. When the uninstallation is complete, click OK.

To uninstall Media Indexer:
1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X System” on page 49).
2. Open a Terminal window (select Applications > Utilities > Terminal).
3. At the prompt, type the following and press Return:
   ```
   cd /Applications/Avid_Uninstallers/MediaIndexer
   ```
4. Type the following and press Return:
   ```
   sudo ./AvidMediaIndexerUninstaller.sh
   ```
   Media Indexer is uninstalled.

If you close the terminal window without uninstalling the program, you can no longer use the terminal window. Workaround: Restart the Macintosh system.

To uninstall Transfer Manager:
- Delete the following file:
  ```
  /Library/Application Support/Avid/xfermgr/intergraphi.bundle
  ```

Installing Interplay | Access

You can install Interplay Access on any system that you want to use to work with the Interplay Engine. Besides installing Interplay Access, this installation also installs the Interplay Administrator.

Interplay Access v3.5 and later is a 64-bit application.
See the following topics:

- “Installing Interplay Access on Windows” on page 50
- “Installing Interplay Access on a MacOS X System” on page 50

For information on using Avid Interplay Access and the Avid Interplay Administrator, see the following manuals:

- Interplay | Access User’s Guide
- Interplay | Engine and Interplay | Archive Engine Administration Guide

Installing Interplay Access on Windows

To install Interplay Access software (Windows):

1. Select the following from the Interplay Client Installer Main Menu:
   Individual Optional Installers > Access
2. Follow the installation instructions.

For information about installing all Interplay components on an Avid editing system, see “Installing Software on Avid Editing Systems (Windows)” on page 43.

Installing Interplay Access on a MacOS X System

Interplay Access is supported on Macintosh® systems running Mac OS X. For more information about using Access with Mac OS X, see the Interplay | Access User’s Guide and the Interplay | Production ReadMe.

Starting with Interplay Access v3.5, a version of Apple Java is installed automatically when you install Interplay Access. Previous versions required you to install Apple Java separately.

To install Interplay Access on a Mac OS X system:

1. Open the Interplay Production Clients Installer.
   The opening screen is displayed.
2. Double-click Install Interplay Access.  
   The first screen of the installer program is displayed.
3. Click Next and continue the installation.  
   By default, Interplay Access is installed in the following folder:  
   Applications/Avid/Interplay Access

To uninstall Interplay Access:
1. Double-click the following file:  
   Applications/Avid_Uninstallers/Interplay Access/Interplay Access Uninstaller.
2. Click Uninstall.
3. When the uninstallation is complete, click OK.

For information about installing all Interplay components on a Macintosh system or removing these components, see the following:
- “Installing Software on Avid Editing Systems (Macintosh)” on page 45
- “Removing Interplay Components from a Mac OS X System” on page 49

Installing Media Composer | Cloud Components

The Interplay Production Client Installer includes a page for installing Media Composer Cloud components (formerly Interplay Sphere). See the following documentation for detailed information:
- Media Composer / Cloud ReadMe
- Media Composer / Cloud Installation and Configuration Guide

For a link to all the Media Composer Cloud documentation, search for “Media Composer Cloud Documentation” on the Avid Knowledge Base.
Installing Optional Software

You can run individual optional installers from the Interplay Server Installer, as described in the following sections:

- Performing a Custom Install of the Avid Service Framework Software
- Installing Interplay | Access or Interplay | Production Services and Transfer Status
- Browsing the Interplay Installer Folders

Performing a Custom Install of the Avid Service Framework Software

The Avid Service Framework (ASF) software is used by a number of Interplay components such as Interplay Capture, Production Services Engine, and Production Services providers. It also lets you monitor the health of other components that have the Service Framework installed and to view logs on the systems.

You install different components of the Service Framework software on different systems in the Interplay Production environment. The individual installation windows automatically install all the components needed for the clients and servers. This installer lets you select and install specific components.

Starting with Interplay Production v3.5, all components are 64-bit applications. Starting with Interplay Production v3.8, only the 64-bit version of Service Framework is available on the Interplay Production installers.

To install a custom version of Service Framework software:
1. Select the following from the Interplay Server Installer Main Menu:
   - Individual Optional Installers
   - The Optional Installers window opens.
2. Click Service Framework.
   The Introduction window opens.

3. Click Next.
   The Choose Install Folder window opens.

4. Accept the default values and click Next.
   The Join a Workgroup window opens.

5. Type the name of your Workgroup and click Next.

   Use the same Workgroup name on all Interplay clients. You can either use the default value or type a name for your Workgroup. The name is case sensitive.
Performing a Custom Install of the Avid Service Framework Software

If you are updating the Service Framework software, the installer remembers the last installed value. If the workgroup name was changed after the install, the installer will not be aware of the change.

The Options window opens.

6. Select the type of Framework installation you wish to make.
7. Click Next.

The Custom Setup dialog box opens. This dialog box displays the components that will be installed.

The following illustration shows the default components for a Framework Client install.
Performing a Custom Install of the Avid Service Framework Software

If this is not the correct set of components, do one of the following:

- Click the Back button and select a different group.
- Select or deselect components from the list in the Custom Setup dialog box.

Don’t add components that you don’t need. This can affect system performance.

8. Click Next and follow the installation instructions to complete the installation.
   The installer might require that you restart your system to complete the installation.

Verifying that the Service Framework Services Are Running

You must perform these steps on each system running the Service Framework Services.

To verify that the Service Framework Services are running:

1. Click the Start button, and then select All Programs > Avid > Service Framework > Avid Workgroup Properties.
   The Avid Workgroup Properties window opens.

   If there is a green check mark next to the “Status” field, all services are running.

2. To view the services, click the Advanced button.
   The Avid Interplay Services dialog box opens.

   This dialog box lets you view all services that are monitored by the Service Framework.

3. If necessary, select a service and click Start.
Disabling Framework Services

Depending on the system you install the Service Framework Services on, you might need to disable some services.

To disable a service:

1. Click the Start button, and then select All Programs > Avid > Service Framework > Avid Workgroup Properties.
   
The Avid Workgroup Properties window opens.
2. Click the Advanced button.
   
The Avid Interplay Services dialog box opens.
3. Select the service you want to disable and click Stop.
4. After the service stops, click the Disable button to disable the service.
5. Click Exit to close the Avid Interplay Services dialog box.
6. Click OK to close the Avid Workgroup Properties window.

Installing Interplay | Access or Interplay | Production Services and Transfer Status

You can install Interplay Access or the Interplay Production Services and Transfer Status tool on any qualified Windows system running in your Interplay environment. This lets you run these applications without affecting the work on other systems such as a server or an Avid editing system.

To install the Interplay Access or Interplay Production Services and Transfer Status software:

1. Select the following from the Interplay Server Installer main menu or the Interplay Client Installer main menu:
   
   Individual Optional Installers
2. Install components from the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Installs the Interplay Access and Interplay Administrator applications. For more information, see “Installing Interplay</td>
</tr>
<tr>
<td>Interplay Production Services and Transfer Status (formerly Media Services and Transfer Status)</td>
<td>This lets you view the status of Interplay Transfer and Interplay Production Services jobs.</td>
</tr>
</tbody>
</table>

**Browsing the Interplay Installer Folders**

**To browse the Installer Folders:**

1. Select the following from the Interplay Server Installer Main Menu:
   - Individual Optional Installers.
2. Click “Browse all installers.”
3. (Option) Select any of the installers from the Installers folder, and perform a custom installation.
Installing and Configuring an Interplay Archive Engine

The following topics are covered in this chapter:

- Installing the Interplay Archive Engine Software
- Updating the Interplay Archive Engine Software

For more details on the Interplay Archive Engine, see the Interplay | Production Services Setup and User’s Guide.

Installing the Interplay Archive Engine Software

You need to install the following software on the Interplay Archive Engine server:

- Interplay Archive Engine
- Interplay Access
- FlashNet Client software (see “Installing the FlashNet Client Software” on page 59)

Additionally, you must install the Interplay Archive Provider on a separate server. See “Installing the Interplay Archive Provider Software” on page 59.

The Interplay Archive Engine installation is very similar to the Interplay Engine installation. The following are the main differences:

- It is not necessary to split the database because it is not possible to archive file assets.
- The database is called AvidAM.
- There is no temporary license key. On the Interplay Engine it is possible to connect one Access client to the engine when no permanent license is loaded. This is not possible on the Interplay Archive Engine. It is necessary to load a license before you are able to connect with Interplay Access. It is also necessary to load the license before you create the database. See “Managing Licenses” in the Interplay | Engine and Interplay | Archive Engine Administration Guide for instructions.
- The AvidAM database has fewer predefined folders than the AvidWG database.

The Interplay Archive Engine maintains a database that can be accessed through Interplay Access and the Interplay Administrator tool. For information on configuring the server, see the Interplay | Engine and Interplay | Archive Engine Administration Guide.

For information on using Interplay Access on an Archive database, or archiving from an Avid editing application, see the Interplay | Production Services Setup and User’s Guide.
To install the Interplay Archive Engine software:

1. Select the following from the Interplay Server Installer Main Menu:
   - Servers > Archive Engine
   The Install Archive Engine window opens.
2. Click Archive Engine to install the Interplay Archive Engine on the system. See “Installing the Interplay | Engine Software” on page 21.

Installing the FlashNet Client Software

An Avid Interplay Archive environment requires SGL FlashNet Client software. Typically, your SGL representative installs and configures the FlashNet client software on the Interplay Archive Engine server and the Archive Provider servers. For information on using the FlashNet client, see the documentation provided by your SGL representative.

For the current version of the FlashNet client software and the FlashNet server software, see the “Compatibility Support Matrix: Interplay | Production, MediaCentral Platform, Avid ISIS, and Avid NEXIS,” available from the following Avid Knowledge Base page:


* SGL FlashNet server v6.4 and later supports SGL Direct Connect, which offloads work from the Interplay Archive server to the SGL FlashNet server, resulting in a significant performance increase for archive and restore operations. For more information, contact your SGL representative.

Installing the Interplay Archive Provider Software

You typically install the Interplay Archive Provider software on a separate server for performance reasons. Install the Interplay Archive Provider from the Avid Interplay Production Services page of the Interplay Installer. See “Installing Software on the Production Services and Production Services Provider Servers” on page 26.

* The Interplay Archive Provider requires an Interplay Production Services application key (also referred to as a dongle) or activation of a software license with the Archive and Restore option.

To install the Interplay Archive Provider and Auto Archive software:

1. Select the following from the Interplay Server Installer Main Menu:
   - Servers > Production Services > Install Local Workflow Support > Archive
2. (Option) Also install Avid Interplay Auto Archive (part of Auto Production Services).
3. Install the Service Framework client software. Use the installer on the following page: Servers > Production Services > Production Services.
   - For information on setting up the Interplay Archive provider and Interplay Auto Archive, see the Interplay / Production Services Setup and User’s Guide.
   - For information on activating a software license, see “Software Licensing for Interplay Production” on page 61.
Updating the Interplay Archive Engine Software

When you update the Interplay Archive Engine, do not delete the software using the Add/Remove Programs or any other mechanism for deleting software. If you delete the software, the system deletes the folder structure in place at the time of the update. To update the software, start the Archive Engine installer on the Interplay Servers Installer and follow the installation instructions. The system updates the software without performing a remove operation. This preserves the folder structure.
Software Licensing for Interplay Production

The following topics describe software licensing for Interplay Production components:

- Understanding Software Licensing for Interplay Production
- Upgrading to Interplay Production v3.8 or Later
- Activating a Product
- Deactivating a Product
- Troubleshooting Software Licensing

Understanding Software Licensing for Interplay Production

Starting with Interplay Production v3.3, new licenses for Interplay components are managed through software activation IDs. In previous versions, licenses were managed through hardware application keys (dongles). Dongles continue to be supported for existing licenses, but new licenses require software licensing.

You cannot license a server through a dongle and software license simultaneously. If you install a software license, you must deactivate your product before you can use a dongle again.

Required Licenses

The following Interplay components require a license:

- Interplay Engine and Interplay Archive Engine
  
  For a clustered engine, Avid supplies a single license that should be used for both nodes in the cluster. If you are licensing a clustered engine, follow the procedure to activate the engine on each node of the cluster, using the same System ID and Activation ID for each node.

  Interplay Engine clients (for example, MediaCentral Base and MediaCentral Advanced) also require software licenses, and are activated through the Interplay Engine. For more information, see “Activating Interplay Engine Licenses” on page 65.

- Interplay Transfer and Interplay Transfer FTP DHM
  
  Interplay Transfer does not require a separate license if it is running on the same computer as a Media Composer system that has been activated through a Media Composer license. If the Media Composer system uses a floating license, Media Composer must be running before Interplay Transfer can be started.

- Interplay Production Services providers:
  - Interplay Archive and Restore
  - Interplay Copy
- Interplay Delivery
- Interplay Move
- Interplay Transcode

Each provider requires a separate license. Licenses for Interplay Transcode are supplied for one instance or four instances, to support multiple providers on the same computer. See “Activating Additional Licenses” on page 66.

If you start a Production Services provider, such as an Interplay Archive provider, without activating a software license or without using a previously issued dongle, the provider will start and will run. However, if you attempt to send a job, the job will fail with an error message that states that a valid license is not connected. See “Production Services Provider” on page 71.

- Production Services Engine (standalone)
  Starting with Interplay Production v3.4, a license is available for the Production Services Engine Standalone. This license is not needed if an Interplay Production provider is installed on the same server as the Production Services Engine. However, if no providers are installed on the server, the Engine is considered “standalone” and requires a separate license.

**System ID, Activation ID, and Device ID**

Avid supplies a license in two parts:

- System ID: A number that references the system on which the product is installed
- Activation ID: An alphanumeric string that references the product

A Device ID is needed if you need to activate a product on a system that is not connected to the Internet. See “Activating a Product Without an Internet Connection” on page 68.

**Avid Application Manager**

Starting with Interplay Production v3.8, you use the Avid Application Manager to manage your product licenses. (Previous releases used Avid License Control). Application Manager (in Enterprise mode) is installed at the same time that you install an Interplay Production product that requires a license.

- For an upgrade of a licensed component, see “Upgrading to Interplay Production v3.8 or Later” on page 63.
- For a new installation, see “Activating a Product” on page 64.

The list of products displayed in the Application Manager depends on which products are installed on your system.

*Application Manager is installed only if you install a product through the Interplay Server installer.*

The following illustration shows the Application Manager with the Production Services Engine Standalone activated. The Details panel is displayed, with information about the license. Click the Close link to close the panel.
Upgrading to Interplay Production v3.8 or Later

Interplay Production v3.3.x through v3.7.x used the Avid License Control (ALC) application to activate products. Interplay Production v3.8 or later uses Avid Application Manager, which is installed with any product that requires a license.

Licensing through dongles remains supported.

See the Interplay Production V3.8 ReadMe for limitations.

Interplay Engine

Interplay Engine v3.8 and later installs both ALC and Application Manager. Software licenses that were activated through ALC are automatically activated in Application Manager. Avid recommends that subsequent activation or deactivation be performed through Application Manager.

Interplay Production Services and Interplay Transfer

For v3.8 and later, installation of the Interplay Production Services Engine, individual Production Services, and Interplay Transfer removes ALC and installs Application Manager. For a list of services that require a license, see “Understanding Software Licensing for Interplay Production” on page 61. The following steps are required:

1. Before installing a component, do the following:
   a. Open ALC.
   b. Copy the license information to a file (see “System ID, Activation ID, and Device ID” on page 62). Alternatively, locate the original license information from Avid. You will need this information to activate the license again.
   c. Deactivate the license.

2. Install the component, using the Interplay Server or Interplay Client installer. If Application Manager is not already on the system, it will be installed. Avid License Control is removed.

3. Supply the license information and activate the license, as described in “Activating a Single License” on page 64 or, for multiple licenses for Interplay Transcode, as described in “Activating Additional Licenses” on page 66.

4. After activating the license, restart the service or application.
Activating a Product

The following topics describe how to activate an Interplay Production product:

- “Activating a Single License” on page 64
- “Activating Additional Licenses” on page 66
- “Activating a Product Without an Internet Connection” on page 68

Activating a Single License

Application Manager is automatically installed with any product that requires a license (unless the application is already installed). When you open Application Manager, any installed products that require a license are automatically listed.

The following procedure describes how to activate a license if the server is connected to the Internet. The Offline option is described in “Activating a Product Without an Internet Connection” on page 68.

To activate a single license using the Internet:

1. On the server you want to license, click Start > All Programs > Avid > Application Manager.

   The default location is C:\Program Files\Avid\Application Manager.

   The application opens and displays the Licensing screen. The screen lists the installed products and the current licensing state: Not Activated, Activated, or Deactivated.

2. Locate the product for which you want to activate the license, click the “Select activation method” drop-down list, and select Online.

3. Enter the System ID number and Activation ID that were supplied by Avid.

   Click Paste if you have copied the information to the clipboard.
4. Click Activate.

The application begins the activation process. A message box is displayed.

When the activation is complete, a message confirms the successful activation. The Activate link changes to Deactivate. The following illustration shows that Interplay Move is activated.

To view information about the activation, click the Details link. Use the Copy to Clipboard link at the bottom of the screen to copy and paste this information into another document.

5. Click the close box to exit Application Manager.

**Activating Interplay Engine Licenses**

For an Interplay Engine, the Application Manager displays options for the Interplay Engine (labeled Production Engine) and all client license types, as shown in the following illustration.
For an Interplay Archive Engine, the Application Manager displays an entry only the Archive Engine.

To activate any of these licenses, use the procedure in “Activating a Single License” on page 64. If you need to activate additional client licenses, see “Activating Additional Licenses” on page 66.

If you are licensing a cluster engine, perform these procedures on each node in the cluster. There are no special requirements to activate or deactivate a node before licensing. Log in directly to each node and use the local version of Application Manager to activate the license. Use the same System ID and Activation ID for each node.

The client licenses in the Application Manager activate license keys in the Interplay Administrator, as listed in the following table.

<table>
<thead>
<tr>
<th>Client License as Listed in ALC</th>
<th>Client License as Listed in Interplay Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Central Advanced Connection</td>
<td>KEY-G</td>
</tr>
<tr>
<td>Media Central Base Connection</td>
<td>KEY-J</td>
</tr>
<tr>
<td>Media Composer Cloud</td>
<td>KEY-LI</td>
</tr>
<tr>
<td>Production 3rd Party AMA Storage</td>
<td>KEY-CI</td>
</tr>
</tbody>
</table>

For more information about managing licenses in the Interplay Administrator, see “Managing Licenses” in the Avid Interplay / Engine and Interplay / Archive Engine Administration Guide.

**Activating Additional Licenses**

Two Interplay Production components can be licensed through multiple licenses:

- Interplay Transcode with additional licenses for more than one instance. Interplay Transcode is supported for up to four instances on a single server. Licenses can be supplied in two ways:
  - A license for one instance of Interplay Transcode.

  If you activate a license for a single instance, named “Interplay Transcode 1x,” the Activate Seats option is displayed in case you need to add additional Interplay Transcode 1x licenses.
- A license for four instances of Interplay Transcode.
  
  If you are licensing Interplay Transcode through a multi-seat license, named “Interplay Transcode 4x,” you do not need to activate additional seats. Note that Application Manager always displays the name as “Interplay Transcode 1x.”

- Interplay Engine with additional client licenses. For example, you might have an initial MediaCentral Advanced Connection license for 150 clients, and then need to add a second license for another 150 clients.

You can activate the first license using the procedure described in “Activating a Single License” on page 64. If you then need to activate an additional license, use the following procedure.

**To activate additional licenses:**

1. On the server you want to license, click Start > All Programs > Avid > Application Manager. The default location is `C:\Program Files\Avid\Application Manager`. The application opens and displays the Licensing screen. The window lists the installed product and the currently activated license. The following illustration shows that Interplay Transcode is installed and one license is activated. The Activate Seats menu is displayed.

   ![Application Manager](image1)

   The following illustration shows that an Interplay Engine license for 150 Media Central Advanced Connection seats is activated.

   ![Application Manager](image2)

2. Click the Activate Seats menu and select Online. Text boxes for the System ID and Activation ID are displayed.
3. Enter the System ID and Activation ID for the additional license.
4. Click Activate.

The following illustration shows two activated licenses for two instances (seats) of Transcode.

5. If you have an additional license to activate, click Activate Seats and complete steps 2 through 4.
6. When you are finished with the Application Manager application, click the Close button.

**Activating a Product Without an Internet Connection**

If the product you want to activate is installed on a server that does not have an Internet connection, use this procedure. Completing the procedure results in delivery of a license.bin file, which you use to activate the product. You must have the System ID and Activation ID before starting the procedure.

**To activate an Interplay Production product through a different computer connected to the Internet:**

1. On the server that has the product you want to activate, click Start > All Programs > Avid > Application Manager.
   
   The default location is C:\Program Files\Avid\Application Manager.

   The application opens and displays the Licensing screen. The screen lists the installed products and the current licensing state: Not Activated, Activated, or Deactivated.
2. Locate the product that you want to activate, click the “Select activation method” drop-down list, and select Offline. Fields to enter the license information are displayed, along with information about how to obtain a license.bin file.

3. Enter your System ID and Activation ID. Click Paste if you have copied the information to the clipboard.

4. Copy the following information and bring it with you to a computer that is connected to the Internet:
   - System ID
   - Activation ID
   - Device ID
   - URL: http://www.avid.com/license

   For convenience, you can use the Copy to the Clipboard link at the bottom of the screen and paste the information to an email message or other file.

   *If necessary, you can close the Application Manager now, and start it again after you have obtained a license.bin file.*

5. On a computer with an Internet connection, open a Web browser and navigate to http://avid.com/license.

   The Software License Activation page is displayed.
6. Enter the required information and the optional email address. Then click Submit.
   The Activation tool confirms your system information. When the activation is complete, a
   message informs you that your software has been successfully activated. The license.bin file is
   downloaded and sent to your email address, if you supplied it.

7. Copy the license.bin file to a network location or a USB drive and return to the server where you
   want to activate the product.

8. Reopen the Application Manager and follow steps 1 and 2.

9. Click Browse to locate the license.bin file, then click Open.

10. Click the close box to exit Application Manager.

**Deactivating a Product**

You might need to deactivate a product. For example, you might want to move the license from one
server to another.

The application retains the deactivated System ID and Activation ID so that you can easily reactivate
the license if necessary.

⚠️ **If you deactivate Interplay Transcode, and then activate it again, the service starts but the**
   **Interplay Transcode window is not launched. To fix this problem, open Windows Task**
   **Manager, click the Processes tab, right-click each instance of DMSTranscode.exe, and select**
   **End Process. Then start Interplay Transcode again.**

**To deactivate an Interplay Production license using the Internet:**

1. On the server you want to license, click Start > All Programs > Avid > Application Manager.
   The default location is `C:\Program Files\Avid\Application Manager`.
   The application opens and displays the Licensing screen.

2. Locate the product for which you want to deactivate the license, and then click the Deactivate
   link.
Troubleshooting Software Licensing

Activation Failed

If you enter license information for a license that is already activated, the following message is displayed:

“Activation Failed: 101 Activation Failed. 20062:Add-on activation-id cannot have more copies assigned than total available.”

In this case, check to see if the license is used on a different server.

No Internet Connection

After you enter your activation ID and system ID, and click Activate, the application tries to connect to the Avid activation server. If there is no Internet connection, or the Internet connection is unavailable, a message is displayed at the bottom of the screen.

Production Services Provider

If you start a Production Services provider, such as an Interplay Archive provider, without activating a software license or without using a previously issued dongle, the provider will start and will run. However, if you attempt to send a job, the job will fail with an error message that states that a valid license is not connected. Where the message is displayed depends on the type of Production Service:

• A Production Service that runs as an application (STP Encode, Transcode) displays a a pop-up message when you click Connect in the application window.

• A Production Service that runs as a Windows service (Archive, Copy, Delivery, Move, Restore) does not have an application window and displays a message in the Production Services and Transfer Status window after a job is submitted.
8 Additional Configuration Topics

This chapter covers the following topics:

• Using Antivirus Software in an Interplay | Production Environment
• Troubleshooting Firewalls and Interplay | Production
• Integration of Journal Data into the Database
• Mounting Workspaces as Drives: Lettered versus Letterless
• Using Time Synchronization in an Interplay | Production Environment
• Installing the Lookup Service on a Separate Server
• Connecting Systems Directly to the Lookup Service

Using Antivirus Software in an Interplay | Production Environment

Interplay supports the Antivirus and Spyware components of Symantec™ Endpoint on servers and clients.

Interplay does not support the following components:

• Proactive Threat Protection
• Network Threat Protection

The Knowledge Base article “Symantec on Interplay Production and Interplay Central” lists the currently supported version of Symantec Endpoint and describes how to install and configure it in an Interplay environment.

Troubleshooting Firewalls and Interplay | Production

Firewalls on client machines interfere with Interplay Production’s TCP/IP communications.

Symptoms

• The list of servers does not appear, for example, when you are connecting to a new database.
• Connection establishment to the server fails.

Cause

These problems can be caused by personal firewalls installed on the client machine. A typical example for such a firewall is ZoneAlarm® from ZoneLabs™or the Windows 7 firewall.

These applications intercept all outgoing and incoming network traffic and decide whether to let the traffic go through or block it. The effect is that applications like Interplay Production fail to connect to their servers.
Typically when the client looks for available Interplay Engines in the network, no servers can be retrieved. When the client is looking for servers, a UDP broadcast is sent out on port 8321.

**Solution**

Usually these personal firewalls can be configured to allow all network traffic for specific applications. This should be done for Interplay Production locally or for Internet access depending on which servers Interplay Production should connect to.

For information about ports used by Interplay Production, see “Interplay | Production and Related Products Port Usage” on page 103.

---

**Integration of Journal Data into the Database**

The Interplay Engine database consists of a core database store and a single permanent journal file. The journal file holds the current binary data changes that are not yet written through to the core database. The core database and the journal file are both contained in the _Database folder.

Prior to Interplay version 2.1, the Interplay Engine created multiple journal files, and it was important for administrators to monitor the number of journal files created. This monitoring is not needed for Interplay version 2.1 and higher.

Both core database and journal file are used for engine operations, like ingest, searching, or deletion. The integration of data in the journal file into the core database is happening constantly in a background thread.

The journal file can grow in size when the Interplay Engine is extremely busy (for example, during a database schema upgrade), but will eventually shrink back to its default size (8 MB for the CCS database _InternalData, 32 MB for AvidWG and AvidAM). Journal integration is no longer suspended when a backup is performed. Therefore, journal data does not accumulate when a backup is running.

**If a Severe Error Occurs**

If a severe error occurs during integration of journal data into the core database, the Interplay Engine suspends the integration. Such severe error cases include:

- Failure of integration of journal data into the core database
- Failure to read/write from the journal file
- Failure to do deletes in the streamed property store (this is a central step in the journal integration)

Usually in such cases, the Interplay Engine rejects all further write operations and reports an error code in the server log and to the clients trying to perform write operations. There are cases where the Interplay Engine can continue operating and adding data to the journal file, but this data is not integrated into the core database.

Journal integration relies on disk access to the _Database folder at all times.
There is one point in time when the engine relies on the journal integration to be finished (at all other
times it is done in a parallel thread). This one point is when a database is loaded, for example, when a
database is brought up, a failover was triggered, or a cluster was taken offline and back online. At this
point, when the database is loaded, the journal integration is enforced. Integration needs to go
through and finish so that the database can be cleared and go online (be accessible by clients).

Mounting Workspaces as Drives: Lettered versus Letterless

Avid editing applications and Interplay Assist require Avid shared-storage client software to function
as clients in an Interplay Production workgroup. Explicit mounting of workspaces as drives might or
might not be necessary, depending on your particular workflow. In general, there is no harm in
mounting the workspaces that you need.

The following information applies to mounting workspaces in an Interplay environment:

- For a Media Indexer that monitors ISIS or Avid NEXIS shared storage, you must select the “Use
  UNC (Letterless) Drive Mapping” option in the Client Manager that is installed on the Media
  Indexer server.
- Avid editing applications require login to the shared-storage Client Manager to read from a
  workspace.
  
  If your Windows username and password exactly match the Avid shared-storage username and
  password, login is automatic. If your Windows username and password do not match, you need
to log in through the Client Manager.

  Drive mappings for read operations are not required except on Mac OS X systems.

  Avid editing applications running on Mac OS X systems require drive mapping for any workspaces
  that you use for reading or writing.

  • In addition to a valid login, Avid editing applications must use drive mapping for any workspaces
    that you write to.

  For Windows systems, you must use lettered drive mapping. If you do not use lettered drive
  mapping you cannot select a workspace in the Volume menu in the Capture tool, in the Media
  Creation tool, or in the Import dialog box.

  • In addition to a valid login, Avid editing applications and Interplay Assist require the following
to use the Send to Playback feature:

    - A workspace to which the logged-in user has write access must be specified in the Editor
      Database Settings view of the Interplay Administrator, in the option “Media Creation
      Workspace.”

      When the user sends to playback, the application searches the workspaces to which the user
      has write access and writes a temporary file to a Temp folder at the top level of the
      workspace with the most free storage space.
On Interplay Assist, if your workflow includes sending Long GOP (XDCAM HD or XDCAM EX) media to playback, you need to mount at least one of the workspaces to which you have write access as a lettered drive. If you do not have at least one workspace mounted as lettered drive, you get an error message “Unable to find a shared storage volume for media transfer.”

- To use Interplay Transcode and other Production Services, you must mount at least one workspace for each shared-storage system that you use for reading and writing on the provider system. You can mount the workspace as a UNC drive or a lettered drive. In most cases, you do not need to mount each workspace that you use, but there is no harm in doing so. For Interplay Transcode, if you use lettered drives, you must mount the target workspace.

Note the following:
- Starting with version 2.6, the Interplay Transcode service and the STP Encode service require you to choose during installation how shared-storage workspaces are mounted: by drive letter or by UNC path. For multiple shared-storage workgroups, select UNC paths if the number of workspaces required for the client exceeds the available drive letters. Mount the workspaces before you start the service.

For more information on mounting workspaces as drives, see the Client Manager Help.

**Using Time Synchronization in an Interplay | Production Environment**

The following two time sync methods are commonly used in Interplay Production environments:


- Interplay Time Synchronization provided with the Avid Service Framework. This method is described in the following section.

**Using the Avid Service Framework Time Sync Feature**

*Slave Time Sync services are only useful to set the local PC clock. If you aren’t using your slave Time Sync to set the local PC clock, you can disable the Time Sync service on that computer.*

The Avid Time Synchronization Service enables time synchronization between different machines in a workgroup. The Time Synchronization Service can operate in either Master mode or Slave mode. In Master mode, the service retrieves a reference time from a configured time source and redistributes it to the Slave services within the workgroup. The time source can be the local PC clock, an NTP server, or an Adrienne timecode card installed in the server. If multiple Time Synchronization Services are configured as Master, they coordinate among themselves and identify one Primary service to distribute the time notifications (the others are in Backup mode and silent until a Primary fails, at which time one of the Backups takes over). In Slave mode, the Time Synchronization Service listens for time notifications from the workgroup and (optionally) sets the local PC clock to match.
The following are the three typical ways of implementing Time Synchronization in an Interplay environment:

- In Interplay environments that use Interplay Capture, a Capture system is usually designated as the Time Sync master. The Capture system can have an Adrienne card. Install the Service Framework Time Synchronization service on the Capture system and configure it as a Time Sync master.

- If you don’t use an Interplay Capture system, do one of the following:
  - Designate another system with an Adrienne card as the Time Sync master. Install the Service Framework Time Synchronization service on this system and configure it as a Time Sync master.
  - Use an NTP server for Time Sync reference. Install the Service Framework Time Synchronization service on a system on the network that does not need to be shut down frequently and configure the service as a master. When you configure the master, point to the NTP service for time sync.
  - Designate any system that rarely has to be shut down as the Time Sync master and set the Time sync reference to the internal PC clock on that system.

It is important to use only one time synchronism mechanism to set the local PC clocks in the Interplay environment. If a Time Synchronization Slave service is configured to set the local PC clock and it detects that some other mechanism (such as Windows 32 Time Services) changes the local clock, the Time Sync Slave service disables itself to avoid the local clock from jumping back and forth. The Time Sync slave also posts a Warning in the Health Monitor.

When you install the Time Synchronization service on a system it runs as a Time Sync slave by default. For information on how to configure a Time Sync master, see “Configuring the Time Sync Master” on page 76.

**Time Sync and Log Files**

All “Framework enabled” services that produce log files listen to the timestamps sent out by a Time Sync Master. They do this to produce a “Sync Time” field in the log files. So, even if the local PC clocks on all the computers do not match, the “Sync Time” field in the log files is always in sync across all the log files on all the machines.

**Configuring the Time Sync Master**

**To configure the Time Sync Master:**

1. Install the following Service Framework components on the system that will be used as the master:
   - Core Components
   - Configuration Utility
   - Diagnostic Log Viewer
   - Health Viewer
   - Machine Monitor
   - Time Synchronization

2. On any system that has the Interplay Configuration Utility installed, click the Start button and select All Programs > Avid > Service Framework > Avid Interplay Service Configuration. The Interplay Service Configuration window opens.
3. Select the system that will be the Time Sync master and click Avid Time Synchronization. The Time Synchronization Settings window opens.

![Avid Interplay Service Configuration Window](image)

4. Select options as described in the following table.

<table>
<thead>
<tr>
<th>Time Synchronization Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Stamp Interval (in seconds)</strong></td>
<td>Determines how often the master sends out time stamp information. The default is 10 seconds.</td>
</tr>
<tr>
<td>Get Time Sync reference from the local PC clock</td>
<td>Select if you are simply using the local PC clock of one system on your network for time sync reference.</td>
</tr>
<tr>
<td>Get Time Sync Reference from an NTP server</td>
<td>Select when you are pointing to an NTP server on your network for time sync reference.</td>
</tr>
<tr>
<td>Get Time Sync reference from an internal Time Code Reader</td>
<td>Select when the Time Sync master system has an Adrienne timecode card.</td>
</tr>
</tbody>
</table>

**Installing the Lookup Service on a Separate Server**

If you have more than 10 clients in your Avid Service Framework environment (including Avid editing applications and Avid Assist), Avid strongly recommends that you put the Service Framework Lookup Service on a separate server such as a General Purpose Server. For redundancy, you may decide to set up two separate servers running the Lookup Service. The following section describes how to install the Lookup Service on a separate server.
To install the Lookup Service on a separate server:

1. Select the following from the Interplay Server Installer Main Menu:
   - Individual Optional Installers
2. Double-click Avid Service Framework Custom.
3. Follow the onscreen instructions and watch for the following items:
   a. Enter your Workgroup name in the Workgroup Name window.
   b. In the Options window, select “Typical Avid Interplay Server Install”.

Configuring Lookup Servers

After you complete the installation, use the Avid Interplay Service Configuration tool to check that the Lookup Service is not running on other Interplay servers, particularly on Media Indexer servers. You can use the Avid Service Framework Workgroup Properties tool to disable the service on other servers.

For best results, connect each system running the Service Framework to the Lookup Service manually via the Workgroup Properties tool. This technique is called Unicast Discovery and is described in “Connecting Systems Directly to the Lookup Service” on page 79. Unicast Discovery ensures a direct connection to the Lookup Service.

Technically there is no need for Unicast Discovery on a local subnet that contains a Lookup Service. Unicast Discovery ensures connection to the Lookup Service but takes extra time to configure on a large workgroup since you have to make the connection manually on each system.

The Avid Service Framework installer has an optional service named Multicast Repeater that can be used to communicate across subnets. Multicast Repeater is no longer recommended because it relies on a single point of communication across the subnets.

When working with multiple subnets, use Unicast Discovery on the remote subnets. Unicast Discovery allows for fast registration and discovery operations for systems on remote subnets.

If you use more than one Lookup Service, use Unicast Discovery to connect to both Lookup Services on each machine.

Interplay System Configuration Service

Use the Interplay Service Configuration tool to check for occurrences of the System Configuration Service on any of your Interplay servers. This service should only run on the systems that contain the Lookup Service. Use the Workgroup Properties tool to disable the service on any other servers.

The System Configuration service is different from the Service Configuration tool. The Service Configuration service runs the Interplay Service Configuration tool and can be installed on any system running the Service Framework.
Configuring Lookup Servers with Shared Storage

Avid recommends that you single connect the LUS using the following guidelines:

- Single connect a LUS to each VLAN. In this case, use Unicast Discovery as follows:
  - On each LUS system, open the Workgroup Properties tool, click the Lookup tab, and enter the fully qualified domain name of the other LUS system.
  - On each client, open the Workgroup Properties tool and specify the fully qualified domain name of both LUS systems.
- The Interplay router needs to have a route configured between the two VLANs.

Do not dual connect a LUS. To achieve redundancy, it is better to single connect a separate LUS to each VLAN.

There is no load balancing between Lookup Services. If you have two LUS systems they operate independently of each other. All Framework services register with both services. To ensure connectivity between subnets, use Unicast Discovery to connect all of your clients to both LUS.

Connecting Systems Directly to the Lookup Service

For systems on remote subnets, Avid recommends that you connect directly to the Lookup service using a technique known as Unicast Discovery.

The main drawback to using the Unicast Discovery connection method is that if there are multiple systems running the lookup service, you should connect to each one. This can take a lot of configuration time in a large installation. If you don’t connect to all of the Lookup service systems, if the one you are connected to goes down you lose your connection to the Service Framework.

To directly connect a system to a Lookup service:

1. Determine the fully qualified domain name of the system running the Lookup service. For example, the following defines the domain name of the server named DocWG:
   
   docwg.global.avidww.com

2. On the system on the remote subnet, click the Start button, and then select All Programs > Avid > Service Framework > Avid Workgroup Properties.

3. Click the Lookup tab.

4. Select the Workgroup that you want to connect to and click Add in the Lookup services window.

   If the name of the workgroup that you need does not appear in the Workgroup area, click the Add button and add the entry. Remember that the name is case sensitive.

5. In the Lookup services area, type in the fully qualified domain name of the system running the Lookup service.

6. Leave the port value at the default 4160.

7. Click Expected and click OK.

8. The domain name appears in the Lookup services area, as shown in the following example.
In this example, the name of the workgroup is the same as the name of the machine running the Lookup service.

9. Click Apply and click OK.
The following topics describe support for multiple shared-storage systems in a single workgroup:

- Understanding a Multiple Shared-Storage Workgroup
- Check List for Adding Multiple Shared-Storage Systems to a Workgroup
- Requirements for Multiple Shared-Storage Workgroups
- Adding Remote Shared-Storage Systems to Client Software
- Adding Remote Shared-Storage Systems in the Interplay Administrator
- Configuring Media Indexer for Additional Shared-Storage Systems
- Mounting ISIS Workspaces as UNC Paths
- Working with Production Services and Interplay Transfer in a Multiple Shared-Storage Workgroup

**Understanding a Multiple Shared-Storage Workgroup**

Interplay supports up to three shared-storage systems managed by a single Interplay Engine and configured in a single workgroup. Using multiple shared-storage systems allows you to expand available storage for your Interplay Production workgroup.

An Interplay Production workgroup requires at least one shared-storage system. Interplay Production v2.6 and later allows you to integrate one or two additional shared-storage systems, for a total of three. Interplay Production supports a workgroup that includes all ISIS systems, all Avid NEXIS systems, or a mixture of ISIS and Avid NEXIS systems.

In a workgroup that mixes ISIS and Avid NEXIS systems, all servers that need to access the shared-storage systems must be running an Avid NEXIS client that can connect to the configured ISIS and Avid NEXIS systems. An Avid NEXIS client can connect to ISIS v4.7.5 or later.

Interplay Move v2.6 and later can be used for high-speed transport of media between multiple shared-storage systems. For more information, see “Working with Production Services and Interplay Transfer in a Multiple Shared-Storage Workgroup” on page 90.

A 10-GB switch and 10-GB connections are recommended as high-bandwidth links between the shared-storage systems. For more information, see “Requirements for Multiple Shared-Storage Workgroups” on page 85 and the following configuration example.

**Local Shared-Storage System and Remote Shared-Storage Systems**

An Interplay workgroup requires one shared-storage system that shares the same subnet with the Interplay workgroup. This ISIS or Avid NEXIS system is considered the local system. You can use the client software on the Interplay Engine to add an ISIS or Avid NEXIS system that exists on a different subnet. This shared-storage system is considered a remote system.
The following illustration shows an example of a multiple shared-storage configuration. The local ISIS system is an ISIS 7000, dual-connected to an Avid network switch through subnets VLAN 10 and VLAN 20 (Zones 1 and 2). The remote ISIS system is an ISIS 5000, single-connected through VLAN 30, a different subnet on the same switch (Zone 3). A Media Indexer is dual-connected to the same subnets as the Interplay Engine and local ISIS system. This Media Indexer is configured to scan both the local ISIS system and the remote ISIS system.

### Multiple ISIS Configuration

![Multiple ISIS Configuration Diagram](image)

The following illustration shows a similar configuration, with an ISIS 7000 and an Avid NEXIS | E4.

### Avid ISIS and Avid NEXIS Configuration

![Avid ISIS and Avid NEXIS Configuration Diagram](image)
These illustrations shows one example of an Interplay network configuration. Other configurations are also supported if each System Director is in its own Zone 3 subnet.

Limitations

- Each workspace name in the workgroup must be unique. There can be no duplicate workspace names across the multiple shared-storage systems.

This restriction is especially important when using Interplay Access for tasks that require reference to a workspace, such as delete and search. In those parts of Interplay Access that require a workspace name, you cannot specify a shared-storage server name, only a workspace name.

You can view the complete path for files, including the shared-storage server and workspace, in the File Locations tab of the Object Inspector.

- The Interplay Media Indexer application monitors the multiple shared-storage systems. The total number of files that the Media Indexer can monitor sets the limit for the number of files supported in a multiple shared-storage workgroup. See “Media Indexer Database Storage Capacity” in the Interplay / Production Best Practices Guide.

- There can be only one copy of a media file in the entire workgroup. The Copy service is not supported for copying assets from one shared-storage system to another within the same workgroup.

- Adding additional shared-storage systems does not increase the number of shared-storage clients that are supported in the workgroup.

Avid Editing Systems Support

Users of Avid editing applications (NewsCutter, Media Composer) and Interplay Assist can edit using media from any shared-storage system to which they have access. On each system, the shared-storage client software must be configured for additional shared-storage systems. See “Adding Remote Shared-Storage Systems to Client Software” on page 86.

Playback of a sequence with clips from multiple ISIS 7500 - 7000 systems, multiple ISIS 5500 - 5000 systems, or a combination of the two systems is qualified. Playback of a sequence with clips from an ISIS 2500 - 2000 and an ISIS 5500 - 5000 or ISIS 7500 - 7000 is not qualified.

Media Creation Workspaces

The Media Creation Workspace setting in the Interplay Administrator sets the workspace used for media clips created by Assist users, such as voice-over recordings and clips created during send-to-playback operations. Beginning with Interplay v2.6, the displayed workspaces include the hostname of the shared-storage server in a UNC path. All existing settings are retained as part of an upgrade to v2.6 or later and you do not need to change them.

The UNC paths are not displayed until the first time you set or change the Media Creation Workspace setting.
For a multiple shared-storage workgroup, the Media Creation Workspace setting is affected in the following ways:

- If you do not list shared-storage servers for Avid ISIS Authentication in the User Authentication view of the Interplay Administrator, the Media Creation setting shows accessible workspaces for all shared-storage systems that are configured through the shared-storage client on the Interplay Engine.

- If you list shared-storage servers for Avid ISIS Authentication in the User Authentication view of the Interplay Administrator, the servers that you specify determine which workspaces are displayed. This occurs whether or not ISIS user authentication is activated. For example, if you specify SysDirector_A, only workspaces on SysDirector_A are listed. If you specify SysDirector_A and SysDirector_B, workspaces on both systems are listed. See “Adding Remote Shared-Storage Systems in the Interplay Administrator” on page 89.

*The Interplay Administrator setting for Avid ISIS Authentication also applies to Avid NEXIS authentication.*

To view a list of available workspaces, the user logged into the Interplay Administrator (username) must have a matching username and password on the Avid shared-storage system. The list shows all workspaces to which the logged-in user has write access.

**AirSpeed Server Support**

AirSpeed Multi Stream and AirSpeed 5000/5500 server support:

- Simultaneous send-to-playback operations from multiple shared-storage systems are supported (v1.8.x and later).
- Recording to a remote shared-storage system is not supported.

AirSpeed Classic is not supported.

**Check List for Adding Multiple Shared-Storage Systems to a Workgroup**

Use this checklist to add one or two remote shared-storage systems to a workgroup that already includes a local shared-storage system.

<table>
<thead>
<tr>
<th>Task</th>
<th>Section Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Review the requirements for adding a remote shared-storage system.</td>
<td>“Requirements for Multiple Shared-Storage Workgroups” on page 85</td>
</tr>
<tr>
<td>✗ Integrate the additional shared-storage system or systems into the network.</td>
<td>“Understanding a Multiple Shared-Storage Workgroup” on page 81, Avid shared-storage documentation.</td>
</tr>
<tr>
<td>✗ Upgrade to Interplay v2.6 or later.</td>
<td>Avid Interplay / Production ReadMe</td>
</tr>
<tr>
<td>✗ When upgrading Interplay Transcode and STP Encode, select the option to mount shared-storage drives as UNC paths.</td>
<td>“Mounting ISIS Workspaces as UNC Paths” on page 90</td>
</tr>
</tbody>
</table>
Requirements for Multiple Shared-Storage Workgroups

Avid Shared-Storage Hardware and Software Configurations

Currently up to three shared-storage systems are supported for a single workgroup:

- Up to three Avid ISIS systems
- Up to three Avid NEXIS systems
- A combination of ISIS and Avid NEXIS systems (up to three).

Note the following requirements:

- Avid ISIS v4.0 or later server and client software is required. Any version of Avid NEXIS server and client software is supported. For compatibility with Interplay Production, see the compatibility matrix for Interplay Production, Avid ISIS, and Avid NEXIS products, which is available from the following Avid Knowledge Base page:
  

- In a workgroup that mixes ISIS and Avid NEXIS systems, all servers that need to access the shared-storage systems must be running an Avid NEXIS client that can connect to the configured ISIS and Avid NEXIS systems. An Avid NEXIS client can connect to ISIS v4.7.5 or later.

- Avid recommends that all shared-storage systems are connected through a 10-GB network. The network topology should be determined by the site requirements. See the examples in “Understanding a Multiple Shared-Storage Workgroup” on page 81.

Interplay Software

All components in the workgroup must be running Interplay version 2.6 or later.

---

### Table: Requirements for Multiple Shared-Storage Workgroups

<table>
<thead>
<tr>
<th>Task</th>
<th>Section Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create accounts for the Server Execution User and Interplay users on each additional shared-storage system.</td>
<td>Avid ISIS or Avid NEXIS documentation</td>
</tr>
<tr>
<td>Add each additional shared-storage system to the Client Manager on the Interplay Engine.</td>
<td>“Adding Remote Shared-Storage Systems to Client Software” on page 86.</td>
</tr>
<tr>
<td>For shared-storage authentication, specify the server name of each additional shared-storage system in the Interplay Administrator.</td>
<td>“Adding Remote Shared-Storage Systems in the Interplay Administrator” on page 89.</td>
</tr>
<tr>
<td>Configure Media Indexer for each additional shared-storage system.</td>
<td>“Configuring Media Indexer for Additional Shared-Storage Systems” on page 88.</td>
</tr>
</tbody>
</table>
Accounts

The Interplay workgroup and all shared-storage systems must include matching user accounts as follows:

- **Server Execution User**: An account with a user name and password identical to the Server Execution User must exist on the shared-storage systems. This account must have read/write access to the Avid shared-storage workspaces that contain media. Use the shared-storage Administration tool to create this account.

- **Interplay and shared-storage users**: Accounts with identical user names and passwords must exist on the Interplay system and the shared-storage systems.
  - The shared-storage user account must have read/write privileges on the workspaces you want to move from and move to.
  - The matching Interplay user account must have read/write privileges on the folders you want to move from and move to.

Media Indexer

Storage for each additional shared-storage system needs to be configured in a Media Indexer. All Media Indexers need to be configured in one high-availability group (HAG) or Network of Media Indexers (NOMI). For more information, see “Configuring Media Indexer for Additional Shared-Storage Systems” on page 88.

Client Workspace Mounting

If you are working in a multiple shared-storage environment, you must mount at least one workspace for each shared-storage system to which you are connected. You can mount the workspace as a UNC drive or a lettered drive. This requirement applies to Avid editing systems, Interplay Assist, and any Interplay components that require connection to a shared-storage system. On Avid editing systems, a lettered drive is required for write access to a workspace.

Adding Remote Shared-Storage Systems to Client Software

After the local shared-storage system is installed and configured, use the shared-storage Client Manager on the Interplay Engine to add a remote shared-storage system.

The following procedure uses the Avid ISIS Client Manager as an example. You can adapt this procedure for the Avid NEXIS Client Manager.

To add a remote system:

1. Start the Avid ISIS Client Manager by clicking Start > All Programs > Avid > ISIS Client.
2. Click the Remote Host Settings button, as shown in the following illustration.
The Remote Hosts dialog box opens.

3. Enter the hostname for the remote IS-IS server and click the Add (+) button. The IS-IS server appears in the Host list.
4. Click the Apply button (green check mark) and close the dialog box. The remote host is listed in the Systems list.
Configuring Media Indexer for Additional Shared-Storage Systems

One Media Indexer (MI) can index two or more ISIS systems in the same Interplay workgroup. The following limitations apply:

- Each MI in the High Availability Group (HAG) or Network of Media Indexers (NOMI) must have access to all available workspaces.
- Configure the shared-storage client on the MI to recognize all available shared-storage systems. Use the Client Manager to connect to additional shared-storage systems, as described in “Adding Remote Shared-Storage Systems to Client Software” on page 86.
- Configure the leader of the HAG or NOMI to see all of the storage locations that you want to access all shared-storage systems. For example, the following illustration shows connections to the workspaces on two ISIS systems. The two System Directors are named A51-wg1-sd1 and BSI-Multi-ISIS.

### Configuration

<table>
<thead>
<tr>
<th>Media Indexers</th>
<th>Statistics</th>
<th>Storage Browser</th>
<th>Storage Search</th>
<th>Performance Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>A51-WG1-EDIT1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A51-WG1-Edit3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A51-WG1-Hughes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A51-WG1-LOG1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A51-WG1-MI</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHAFFRIS ON-MC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e51-wg1-mel1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e51-wg1-lion2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e51-wg1-sn1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e51-wg2-sn2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>friendzAvid7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>tillcherrmac2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Storage Locations

- \(\text{A51-wg1-sd1}\) VMS1\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) vms2
- \(\text{A51-wg1-sd1}\) vms3\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) Uspd\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) Vms4\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) broadcast\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) loop\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) dms\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) IPv\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) Proxy\Avid MediaFiles
- \(\text{A51-wg1-sd1}\) restore\Avid MediaFiles
- \(\text{A51-wg1-sd1}\)弱点\Avid MediaFiles
- \(\text{BSI-Multi-ISIS}\) Multi-ISIS-1\Avid MediaFiles
- \(\text{BSI-Multi-ISIS}\) Multi-ISIS-2\Avid MediaFiles
- \(\text{BSI-Multi-ISIS}\) Multi-ISIS-3\Proxy\Avid MediaFiles
- \(\text{BSI-Multi-ISIS}\) Multi-ISIS-4\Avid MediaFiles
Adding Remote Shared-Storage Systems in the Interplay Administrator

If your workgroup is configured for shared-storage authentication in the Interplay Administrator (currently displayed as Avid ISIS Authentication), you need to specify each additional shared-storage server name in the User Authentication Providers view. Users can then use their shared-storage credentials to log in to the Interplay database and access any additional shared-storage servers to which they have access.

If you list shared-storage server names for Avid ISIS authentication, the servers that you specify determine which workspaces are available in the Media Creation Workspace setting. This occurs whether or not Avid ISIS authentication is activated. See “Media Creation Workspaces” on page 83.

To configure additional shared-storage systems for shared-storage authentication in the Interplay Administrator:

1. In the User Management section of the Interplay Administrator window, click the User Authentication Providers icon.

   The User Authentication Providers view opens.

2. Click Avid ISIS Authentication.

3. Click the Add Avid ISIS button.

4. Type the System Director hostname for the additional shared-storage systems.

   Click the Remove Entry button to delete a hostname.

   The name that you type depends on the configuration of the shared-storage system.

   - For a configuration with a single System Director, type the System Director hostname that is set in the Control Panel in the System Director.

   - For a configuration with two System Directors (dual System Director configuration), type the Virtual System Director hostname that is set in the Control Panel for both System Directors. The Virtual System Director Name represents the two virtual IP addresses that you also set in the Control Panel.

   The name you type must match the shared-storage name that appears in the Client Manager that is running on the Interplay Engine. For more information, see the Setup Guide for your shared-storage system.

5. Click Apply.
Mounting ISIS Workspaces as UNC Paths

The first time an Avid ISIS or Avid NEXIS user logs into Interplay, the user is added to the Central Configuration Server (CCS) as part of the UNITY user group under Imported Users, with Read rights by default.

The servers you list in the Avid ISIS Authentication section also determine what workspaces are displayed in the Media Creation workspace setting in the Interplay Administrator. See “Media Creation Workspaces” on page 83.

In the Server Hostname Settings view of the Interplay Administrator, there is a setting for Fallback Shared-Storage Server. In most cases the name of the local ISIS system is entered automatically. If you need to manually enter the computer name, use the name of the System Director for the local ISIS system.

Mounting ISIS Workspaces as UNC Paths

A multiple shared-storage configuration is likely to have a large number of workspaces. Mounting workspaces as UNC paths provides the ability to mount more drives than the number of drive letters available.

Starting with version 2.6, the Interplay Transcode service and the STP Encode service require you to choose how shared-storage workspaces are mounted: by drive letter or by UNC path. For multiple shared-storage workgroups, select UNC path. After installation, configure the Client Manager to use UNC paths.

Working with Production Services and Interplay Transfer in a Multiple Shared-Storage Workgroup

Most Production Services and Interplay Transfer profiles include a setting for shared-storage workspaces. If you are adding remote shared-storage systems to an existing workgroup, your existing profiles will work correctly with the workspaces as they are currently defined. The following sections supply information about creating new profiles.

Move v2.6 and Later and Other Production Services

Interplay Move v2.6 and later supports high-speed transfer of media between multiple shared-storage systems. A 10-GB network is recommended. Existing profiles will work correctly with the workspaces as currently defined. For a new or edited profile that specifies a workspace on a remote shared-storage system, the workspace path must include the hostname of the System Director and the name of the workspace, in the standard UNC format:

\hostname\workspace_name

The following illustration shows an example, in which a51-wg1-sd1 is the System Director for the target shared-storage system, and Highest_Copy is the target workspace.
For more information, see “Working with the Move Service” in the Interplay / Production Services Setup and User’s Guide.

Use the same format for workspaces in other Production Services profiles, such as Delivery and Transcode when the target workgroup includes multiple shared-storage systems. Existing profiles will work correctly with the workspaces as currently defined, but new or edited profiles that specify a workspace on a remote ISIS system must include the hostname of the System Director.

A Move profile is required when moving media from one shared-storage system to another shared-storage system. You cannot select a workspace for a remote shared-storage system in the Move dialog box.

**Interplay Transfer v2.6 and Later**

Interplay Transfer uses a shared-storage workspace for incoming transfers. For easier workspace management, you should include the System Director hostname in a UNC path in the “No-login workspace for incoming transfers” setting in the Avid Interplay Transfer Engine Configuration dialog box.
Configuring the Copy Provider Server

The following topics describe how to set up the hardware and shared-storage connections on a Copy Provider server:

- Workgroup Configuration for the Copy Service
- Creating Copy Provider User Accounts for Shared Storage and Interplay Production
- Copy Provider Configuration for AS3000 Servers

Network connection information for qualified Dell and HP systems is available in Interplay Production Dell and HP Server Support, which is available on the Avid Knowledge Base.

For information about how to use the Copy service, see “Working with the Copy Service” in the Avid Interplay | Production Services Setup and User’s Guide.

Workgroup Configuration for the Copy Service

The following illustration shows the basic workflow for copying metadata and media files. The Copy Provider copies metadata from one Interplay Engine to another, and copies media files from one shared-storage system to another. This example shows a configuration that is used for copying media in either direction (from Workgroup 1 to Workgroup 2, or from Workgroup 2 to Workgroup 1), so a Production Services Engine and Copy Provider are required in each workgroup.
Creating Copy Provider User Accounts for Shared Storage and Interplay Production

The shared-storage systems must be running software that is compatible with the version of Interplay Copy. For compatibility information, see the Compatibility Support Matrix: Interplay | Production, MediaCentral Platform, Avid ISIS, and Avid NEXIS, which is available on the Avid Knowledge Base:


Creating Copy Provider User Accounts for Shared Storage and Interplay Production

Both shared-storage systems and both Interplay Production workgroups must include matching user accounts as follows:

- The user name and password for these accounts must match exactly.
  - The shared-storage user account must have read/write privileges on the workspaces you want to copy from and copy to.
  - The Interplay Production user account must have read/write privileges on the folders you want to copy from and copy to.

The following table summarizes the locations where you must create matching accounts and where they are used.
Avid recommends that you use the same Central Configuration Server (CCS) for both workgroups to make user management easier. For more information on the CCS, see the *Interplay | Engine and Interplay | Archive Engine Administration Guide*.

- You must connect the Copy Provider to both shared-storage systems through the same account. The workspaces must be mounted using letterless drive mappings.

The following example shows the ISIS Client Manager with Composer1 connected to two different workgroups.

### Copy Provider Configuration for AS3000 Servers

The Copy Provider on an AS3000 uses two Myricom PCIe cards. The following illustration shows the rear view of the AS3000.

The AS3000 has two PCIe slots and they both support the Myricom cards. The appropriate drivers are pre-loaded onto the AS3000 images for Windows 7 Pro 64-bit.
Network connection information for qualified Dell and HP systems is available in Interplay Production Dell and HP Server Support, which is available on the Avid Knowledge Base.

To install the Myricom cards:

1. Install the cards in the two PCIe slots as described in the AS3000 Setup Guide.
2. Reconnect and restart the system.

The system automatically recognizes the Myricom cards because the drivers are pre-loaded on the Windows 7 Pro 64-bit image.

If you find it necessary to locate the Myricom drivers, the Myricom drivers folder is located in the following location:

C:\Installables\drivers\nic

The following illustration shows the Myricom entries in the Windows Device Manager.

Making the ISIS Connections on an AS3000

This topic describes two different kinds of network connections. For more information on cabling for Avid ISIS, see the Avid ISIS documentation.

For best performance, do not connect two Copy Providers to the same ISIS system. If you have more than one Copy Provider, connect each to a different ISIS system.

Using the Myricom Cards

When using the Myricom cards, connect the Myricom cards to the ISS 10-GB ports on the Avid ISIS Engines (ISIS 7000 or ISIS 7500) or to 10-GB ports on a qualified switch. Connect the Copy Provider to both Avid ISIS systems.

The following illustration shows the Myricom connections to two different ISIS systems named Big ISIS and WG6.
Unused network connections are disabled in the above illustration. This not required and depends on your site policies. Some sites disable all unused NICs.

Using the 1Gb Onboard NICs on the Copy Provider

When using the 1 GB onboard NIC on the Copy Provider, connect the Pro/1000 PT ports labeled 2 and 4 on the Copy Provider to any 1 GB port on the Avid ISIS Engines (ISIS 7000 or ISIS 7500) or to a 1 GB port on a qualified switch. Connect the Copy Provider to both Avid ISIS systems. Avid does not recommend using the onboard NICs because performance is better using the Myricom cards.

The silkscreen labels on the back of the AS3000 identify the Pro/1000 PT ports as 2 and 4. When you look at the ports in the Network Connections software interface, the two ports are listed as 2 and 3. The above illustration shows how the ports are listed via the Network Connections interface. When you make the physical connection, use the ports labeled 2 and 4 on the back of the AS3000.

Copy Provider ISIS Configurations

Each ISIS Engine (also known as an ISIS chassis) supports a maximum of two Copy Providers:

- One for sending material to a remote workgroup
- One for receiving material from a remote workgroup

If you have multiple ISIS chassis in your workgroup, you can set up multiple sending and receiving providers.

The following illustration shows Copy Providers configured between two workgroups.
Example 1 One send and one receive can use a single chassis on each workgroup.

Example 2 Two simultaneous sends requires two chassis.
Configuring the Move Provider Server

The Move provider is used to move files from one shared-storage workspace to another. The following topic describes how to set up the hardware and shared-storage information on a Move provider server:

- Move Provider Configuration for AS3000 Servers

The Move feature works only within a single workgroup. To copy assets and media to a different workgroup, use the Copy Provider.

For information on setting up and using the Move provider, see “Working with the Move Service” in the Avid Interplay | Production Services Setup and User’s Guide.

Move Provider Configuration for AS3000 Servers

This topic describes how to set up the hardware for a Move provider on an AS3000 server.

The AS3000 has two PCIe slots and both support the Myricom cards. The appropriate drivers are pre-loaded onto the AS3000 image for Windows 7 Pro 64-bit. The Move Provider only requires one Myricom card. You can install it in either slot.

Network connection information for qualified Dell and HP systems is available in Interplay Production Dell and HP Server Support, which is available on the Avid Knowledge Base.

To install the Myricom card:

1. Install the card in the either of the two PCIe slots as described in the AS3000 Setup Guide. For convenience, use the bottom slot.

2. Reconnect and restart the system. The system automatically recognizes the Myricom card because the drivers are pre installed on the Windows 7 Pro recovery image.

For an illustration shows that shows the Myricom card in the Windows Device Manager, see “Copy Provider Configuration for AS3000 Servers” on page 94.

If you find it necessary to locate the Myricom drivers, the Myricom drivers folder is located in the following location:

C:\Installables\drivers\nic
Using the Myricom Card on the Move Provider

Connect the Myricom card in the AS3000 to the ISS 10-GB port on the Avid ISIS Engine (ISIS 7000 or ISIS 7500) or to a 10-GB port on a qualified switch.

Using a 1Gb Onboard NIC on the Move Provider

When using a 1 Gb onboard NIC on the Move provider AS3000, connect one of the Pro/1000 PT ports labeled 2 or 4 on the Move provider directly into any 1 Gb port on the Avid ISIS Engines (ISIS 7000 or ISIS 7500). Avid does not recommend using the onboard NICs because performance is better using the Myricom cards.
Installing Cards on the Interplay Transfer AS3000 Server

This chapter covers the following topics:

- Interplay Transfer AS3000 Server Slot Locations and Network Connections
- Installing Cards in the Interplay Transfer AS3000 Server

Network connection information for qualified Dell and HP systems is available in Interplay Production Dell and HP Server Support, which is available on the Avid Knowledge Base.

Interplay Transfer AS3000 Server Slot Locations and Network Connections

The following illustration shows the rear view of an AS3000 server.

AS3000 Back Panel

The Interplay Transfer server runs Windows 7 Pro 64 Bit. The server does not require any PCIe cards. For more information about the AS3000, see the Avid AS3000 Setup Guide.

ISIS and Network Connections

The following table shows the connections for ISIS 5000 and ISIS 7000 on an AS3000 server.

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>ISIS 5000</th>
<th>ISIS 7000</th>
</tr>
</thead>
<tbody>
<tr>
<td>First ISIS connection</td>
<td>Pro/1000 PT Port</td>
<td>Pro/1000 PT Port</td>
</tr>
<tr>
<td>Second ISIS connection</td>
<td>NA</td>
<td>Pro/1000 PT Port</td>
</tr>
<tr>
<td>Network connection</td>
<td>Pro/1000 PT Port</td>
<td>Port 1 or 3. If you have only one ISIS connection, use the second Pro/1000 PT Port for the network connection.</td>
</tr>
</tbody>
</table>

External devices should communicate with the Interplay Transfer engine via the DNS entry of the network connection.
Port Usage on the Interplay Transfer AS3000 Server

For two workgroups to cooperate, some workstations in one workgroup must have access to services in the other workgroup. If these workgroups are not in the same site, or are separated by routers or firewalls, you have to establish access to allow these services to work together.

The main components are an Avid Interplay Engine and two Interplay Transfers. All these services are TCP/IP based.

- The Avid Interplay Engine leverages the standard HTTP service on port 80.
- The Interplay Transfers use port numbers that are defined in the services file in `\WINDOWS\SYSTEM32\DRIVERS\ETC`. As installed, these port numbers are as follows:
  - 6532 - the Interplay Transfer Engine listens on this port for requests from other TM servers (for example, initiating a workgroup transfer).
  - 6535 - This is the default port used by the Interplay Transfer Engine for connecting to playback servers (for example, AirSpeed Multi Stream).
  - 6539 - The Interplay Transfer Engine listens on this port for incoming requests from the Transfer Client.

Interplay Transfer uses ports 6432 and 6535 to communicate with the sending or receiving device. After the Transfer Engine establishes the connection, the OS on the external device assigns a port and notifies the Transfer Engine of the new port number. Then the external device starts listening on that port. Transfer Engine uses the new port number for sending or receiving data.

Installing Cards in the Interplay Transfer AS3000 Server

For information about configuring the AS3000, see *Migrating Interplay Applications to AS3000 Servers*.

The cards included with the Interplay Transfer server depend on the Avid shared storage environment where the Interplay Transfer server is being installed.

In an Avid ISIS environment, the Interplay Transfer server might ship with an Intel® PRO/1000 Server Adapter gigabit card, depending on your system’s configuration. This card must be installed in slot 3 (top slot). Follow the directions supplied with the card. For information on configuring the Intel PRO/1000 card, see “Configuring the Intel PRO/1000 Adapter Card on the AS3000 Server” on page 101.

Configuring the Intel PRO/1000 Adapter Card on the AS3000 Server

For information about configuring the AS3000, see *Migrating Interplay Applications to AS3000 Servers*.

The Intel PRO/Adapter card might require the installation of the Intel Pro/1000 driver. After you install the driver, you need to configure the card to work correctly with the Interplay Transfer server. This section provides procedures for installing the driver and configuring the card for Jumbo Frames.
To install the Intel PRO/1000 driver:
1. Install the Intel PRO/1000 server adapter card and restart your system. A message might appear, looking for the Intel PRO/1000 driver.
2. Open the C:\IntelPro folder.
3. Click the Autorun.exe file.
   The Intel Pro Network Connections window opens.
4. Click Install Drivers.
5. Click Finish.

To configure the Intel PRO/1000 card for Jumbo Frames:
1. Right-click the My Network Places icon, and select Properties.
2. Right-click the file for the Intel Pro interface used by Interplay Transfer and select Properties.
3. Click Configure.
4. Click the Advanced tab.
5. In the Property area, select Jumbo Frames.
6. In the Value area, select 9014Bytes.
7. Click OK.
Starting with Interplay Production v3.5, port usage is described in the *Avid Networking Port Usage Guide*, which is available on the Avid Knowledge Base at the following location: